I know I join the rest of the WAAC community in sadness with the news of Scott Carrlee’s passing. A former WAAC president, Scott was a conservator at the Alaska State Museum in Juneau, where he was responsible for a robust intern program, among other important projects. In this issue, you will find an article about Scott penned by Nancy Odegaard.

Scott introduced me to WAAC in 2009 when I was an intern in Juneau and he was WAAC president. He described WAAC as a small, unique community of conservators without the formality of AIC. All this while he was trying to recruit me to speak at the upcoming meeting. I was more than a little reluctant because I had never spoken at a professional meeting. He assured me that WAAC was a great place to get your feet wet and that the group would be supportive and interested. He was right, of course. Giving that talk was not only painless, but it helped me gain confidence for more “formal” venues. I have many fond memories of my internship in Juneau, particularly of traveling around Alaska with Scott. He encouraged me to take risks, both personally and professionally, a strategy that worked for him and has paid off many times over in my life. I will continue to be inspired by his dedication to cultural heritage, community, and living life to the fullest without apology.

I hope we all have the opportunity to share stories at the upcoming (September 26-30th) meeting at Ghost Ranch. The local planning committee in New Mexico has been diligently working on logistics. Since we are without a local president this year, their role in planning and executing this meeting is especially crucial. So far, their efforts include evening events, an Angel’s project, and giving us the insider’s scoop on local activities. For example, our meeting overlaps with some interesting local events, particularly the San Geronimo Feast Day at Taos Pueblo. If you are still in professional development mode, there are numerous museums and cultural sites in the region for every specialty and interest. Additionally, there is an Artisan Materials Expo at Rolling Thunder Resort & Casino just north of Sante Fe.

O’Keeffe themed events are also in the works that may give opportunities to tour some of her private homes. Regardless, we will have plenty of opportunity to explore and appreciate the landscape around Ghost Ranch that inspired much of O’Keeffe’s work in New Mexico. There are numerous hiking trails at Ghost Ranch, as well as other nearby locations like Abiquiu lake, Christ in the Desert Monastery, the Dar Al Islam Mosque and local archaeological sites. If you are looking for something more luxurious, Ojo Caliente is nearby, offering hot springs and spa services.

### Schedule at a Glance

<table>
<thead>
<tr>
<th>Schedule</th>
<th>WAAC Conference</th>
<th>Wednesday September 26</th>
<th>Thursday September 27</th>
<th>Friday September 28</th>
<th>Saturday September 29</th>
</tr>
</thead>
<tbody>
<tr>
<td>Morning</td>
<td></td>
<td>Angels Project: storage improvement at Ghost Ranch Museums</td>
<td>Conference Program at Agape Center</td>
<td>Conference Program at Agape Center/Tours of GOK home-studio at Ghost Ranch</td>
<td>Conference Program at Agape Center</td>
</tr>
<tr>
<td>Afternoon</td>
<td></td>
<td></td>
<td>Conference Program at Agape Center</td>
<td>Conference Program at Agape Center/Tours of GOK home-studio at Ghost Ranch</td>
<td></td>
</tr>
<tr>
<td>Evening</td>
<td>Welcome Reception at the Art Center (s’mores and hot chocolate)</td>
<td>Reception at O’Keeffe Welcome Center/Tours of GOK home and studio in Abiquiu</td>
<td>Banquet in the Agape Courtyard</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Jennifer McGlinchey Sexton

**President’s Letter**

May 2018

Volume 40 Number 2

**Contents**

- President’s Letter 1
- Annual Meeting Logistics 3
- Regional News 8
- Relighting Chris Burden’s Urban Light using LEDs 16
  by Charlotte Eng, Terry Schaeffer, and Mark Gilberg
- One Device to Document Them All: Exploring an All-In-One Solution for Digital Condition Reporting & Beyond 21
  by Raina Chao and Hugh Shockey
- Membership 26
- AYMHM 27

President Carolyn Tallent, Editor
826 Centinela Ave.
Santa Monica, CA 90403
Don’t miss the opportunity to visit the nearby cities of Sante Fe, Taos, and Albuquerque. Each offer unique character that is difficult to describe or find elsewhere. I have had some opportunity to explore the area since moving to the region in 2016. By far, my favorite discovery has been Meow Wolf, an experiential artist-driven installation in an old bowling alley in Santa Fe. It truly defies description, so I will just implore you to go (and bring the kids).

In this issue, you will find a call for nominations. Member participation in WAAC is vital to our organization, and I encourage you to speak up to make your voice heard either as Member at Large, VP, or by nominating a worthy colleague. I have enjoyed my tenure on the board as a MAL and hope to continue to do my part to keep our unique WAAC community thriving.

Jennifer McGlinchey Sexton, MAL

Angels Project
September 26, 2018, 9:00 AM – 5:00 PM

Do you like fossils and archaeological materials?

Then please join us for this one-day storage improvement project at the Florence Hawley Ellis Museum of Anthropology and the Ruth Hall Museum of Paleontology, the onsite museums at Ghost Ranch!

This will be the first time that the museums have the opportunity to work with professional conservators. The work will include preparing fitted, padded storage containers for individual fossils. Ghost Ranch is the top dinosaur fossil site in the world for the Triassic period, and the Ruth Hall Paleontology Museum highlights dinosaurs found on-site. The size of this museum belies the importance of its collection.

Gretchen Gürtler with assistance from Axel Hungerbeuhler, both from the Mesalands Dinosaur Museum in Tucumcari, NM, will lead the project, with Susan Barger as Angels Coordinator.

Due to the limited size of the working spaces at the museums, participation will be limited.

Angels will receive a 50% discount on Ghost Ranch accommodation Tuesday night. The Angels Project is generously supported by an FAIC grant and Ghost Ranch. Details on how to sign up will follow.
Silent Auction

Last year the auction benefitted terrifically from the fact that a member had moved her studio and cleared out a lot of accumulated bits and books, etc., which she donated.

Perhaps this will nudge some, or maybe lots, of you to sort through the cabinets and shelves for things that you haven't used in ages. To someone else, these may be treasures.

.... and then there are the oddities: specialty foods, objets d'art, random items of the culture.

So many people will say at the meeting "oh, I meant to bring something."

This year, remember. Put a box or bag in a corner of the studio and add things as you come across them. It's as much fun to see your items bid on as it is to win a fiercely contested bidding.

Any questions should go to Carolyn Tallent.

---

Call for Papers

In the best WAAC tradition, a wide range of presentations are eligible for consideration, so come and share. We are particularly interested in papers that push the boundaries and challenge the profession to re/consider roles, responsibilities, techniques, and ideas.

Since the meeting will take place in New Mexico, papers related to the art and history of the region are particularly welcome. Please keep in mind that individual presentations will be 25 minutes in length. However, suggestions for multi-session panels, incorporating multiple speakers, will also be welcomed.

Abstracts should be submitted no later than July 1, 2018.

Questions and proposals can be submitted to:
Sue Ann Chui
Food
Like Asilomar, meals will be included. Food is served cafeteria style, and there are vegetarian options. Gluten free and vegan meals will have to be arranged. Food is served in the Dining Hall 7:30 – 8:30 Breakfast, 12:00 – 1:00 Lunch, and 5:30 – 6:30 Dinner. One can linger a bit after most meals, but the hall closes about 7:00 or so every night. There are also tables on a spacious portal and in September it should be possible to eat there comfortably.

There is also a small kitchen at the Agape Center where we will be having the meeting, and some of the housing areas have refrigerators and microwaves.

Housing
Ghost Ranch offers rustic lodging accommodations that are reflective of its origins as a working ranch. The rooms are basic – no frills – but clean and comfortable and offer breathtaking views of the colorful vistas, sandstone cliffs, cottonwoods, and distant mountains.

There are various room choices, with or without bath, some close to the meeting area, some on a mesa with great views but farther away.

(There are golf carts available to rent, about $30/day.)

Instructions on how to make reservations will be provided on the registration page. Reservations are made directly with Ghost Ranch over the phone.

Also, Ghost Ranch is about 15 minutes away from Abiquiu – the location of the Georgia O’Keeffe House. The Abiquiu Inn is located on the main highway, and if one wanted more high class accommodations, they could stay there and commute to the Ranch. There is a restaurant at the Inn for those who might like fancier fare.

Getting there
American and United fly into Santa Fe airport, all other airlines go into Albuquerque. It's 65 miles from Albuquerque to Santa Fe (about an hour’s drive), another 60 miles from Santa Fe to Ghost ranch (about an hour and a half).

Shuttles may be available, information on those should be available with registration materials.
The Sunday after our meeting is the San Geronimo Feast Day at Taos Pueblo, with traditional festivities and a craft fair. There are strict rules and codes of behavior for visiting the pueblo; we are going to try to arrange to have a speaker from Taos to talk about the feast day. Otherwise, this is a decent description by a visitor: wanderwisdom.com/travel-destinations/San-Geronimo-Feast-Day-at-Taos-Pueblo.

A number of small tours are in the works, ranging from a studio open house with a maker of marbled papers in Abiquiu to a tour of local potters.

And of course we anticipate having free admission with WAAC badges at the local museums in Santa Fe, Taos, and possibly Albuquerque. The Georgia O’Keefe Museum is already confirmed.

We will be meeting at the Agape Center which has a great room, the aforementioned kitchen, and a spacious patio with a fireplace, where we can have a fire and hang out. The largest room in the Agape Center has a large folding glass wall that has a beautiful, southern view over the river.

There are two small museums at Ghost Ranch. One is the anthropology museum that has small exhibits of Indian materials, some Hispanic retablos and bultos, and a small exhibit about the history of Ghost Ranch – currently centered on the women who were instrumental in the formation of Ghost Ranch. The Paleontology Museum has exhibits that reflect the dinosaur treasures from Ghost Ranch. This is where the Angel’s Project will take place.

At Ghost Ranch there are hiking trails to go on your own or with a guide, horseback riding, yoga, etc. (Some activities have extra fees.) It is possible to swim or fish at Abiquiu Lake about five miles away. And, there are hikes to various archaeological sites easily accessible from Ghost Ranch.

It is possible to visit Christ in the Desert Monastery (christdesert.org/) for nice hikes.

The Dar Al Islam Mosque (daralislam.org/about) (designed by Hasan Fathy) is nearby, and it is possible to hike to the “White Place” of Georgia O’Keefe’s paintings from the Dar Al Islam parking lot.

Ojo Caliente, a hot springs/spa, is close by (ojospa.com/).

During the weekend of our meeting, the Artisan Materials Expo is taking place at Rolling Thunder Resort & Casino (just north of Santa Fe) with 80 vendors of art materials, apparently at great prices!
Deeply Felt Losses
Scott Carrlee

Scott Allan Carrlee passed away peacefully on the morning of April 3rd at his home in Juneau, surrounded by loved ones. He didn’t choose pancreatic cancer, but he faced it bravely, openly, and with every bit of his incredible strength, humor, and fortitude.

Scott had friends and family around the world. He climbed mountains from Alaska to Nepal, cared for artifacts in Turkey, advised museums in Argentina and Japan, pursued PhD fieldwork in Costa Rica, and traveled frequently in Europe. Scott was as much at home on a mountain as at the bridge table. He had a knack for storytelling and would describe his adventures and friendships with unbridled enthusiasm. He was instantly recognizable both for his appearance and his gregarious, bright-eyed enthusiasm that could recharge anyone around him. Scott was the kind of person who commanded every room he was in without anyone minding.

Scott spent his childhood in rural Indiana, attended high school in Rochester, NY, studied German literature as an undergraduate, and lived in Germany for several years with the Wepler family of Würzburg, with whom he formed a lifelong bond. He returned to the US to earn an MA in art conservation from SUNY Buffalo. Subsequent work included the Arizona State Museum, the Carnegie Museum, the Smithsonian’s National Museum of the American Indian, and archaeological work at Kaman Kalehöyük in Turkey.

Scott came to Juneau in 2001 and immediately took to the city, and all of Alaska, with his trademark energy. Scott loved the people, places, and quirks of life in Alaska. Fellow conservator Ellen Roblee eloped with him at Skater’s Cabin on Mendenhall Lake in Juneau in 2001, and they combined their last names (Carroll + Roblee = Carrlee). They have a 10-year-old son, Carson.

Colleagues and emerging museum professionals alike found Scott an “instant legend” and gravitated to his gregarious personality and willingness to share his encyclopedic knowledge with anyone who might need it. He had a special passion for small museums and the amazing ability to help those he worked with feel more confident. He created an internship program that launched many careers with Alaskan institutions, helped design and build the new Anchorage Museum, and ran a Statewide Services program that won several national awards for the Alaska State Museum.

A celebration of Scott’s life will be held in early August, and a fund will be established in his name to help bring student interns to Alaska for museum work. Contributions to the fund can be sent to the Juneau Community Foundation.

Scott Carrlee and Me - Nancy Odegaard

Many are mourning the passing of our conservation colleague Scott Carrlee and the various obituaries clarify that his all too short life was filled with outstanding achievement. Scott got a lot out of life because he put a lot into it. He worked hard to satisfy his thirst for knowledge, skills, experience, adventure, family, and friendships that in turn made his life rich.

I met Scott in 1991 when he asked to complete his third-year internship from the Buffalo Art Conservation program in our tiny Arizona State Museum Conservation Lab. I’d had interns before but Scott was the first graduate conservation program intern to ask to come. Within months of his arrival I wrote that “I have found him to be particularly agreeable in disposition and [he] has become quite a favorite among the Collections, Exhibitions, and Public Programs staffs.” During his internship, Scott worked on a CAP assessment, participated in an archaeological excavation, lectured to chemistry classes, and worked on our major ethnology hall installation. He delivered his first presentation (based on his internship research) to AASLH, an organization he later worked with extensively. Scott left the ASM to work at the Carnegie Museum of Natural History. Conservator Joan Gardner (I recommended Scott to Joan) sent me a short note in October of 1992 to say “Scott is such a joy! Thank you, thank you, thank you.”

Knowing Scott to be conscientious, capable, and skilled, it was easy to seek his help in compiling the Materials Characterization for Objects of Art and Archaeology book (2000, 2nd ed 2005). Scott was working in Turkey at the Kaman-Kalehöyük for half-year field seasons so during the winter months in 1996-1998 he agreed to work with Werner Zimmt, Dave Spurgeon, and me in Tucson to run trials of all the tests that would be included in the book and to assist with the final product. Those were particularly wonderful times in the lab, full of conservators, scientists, and interns working on everything from fibers to mentoring programs. Everyone who knew Scott (we referred to him as Spot) during those years enjoyed his kind and generous personality.

Scott went on to work in Pittsburgh, Buffalo, New York City, Washington DC, and Juneau. His breadth of knowledge, skills, and experience were always expanding, if only to match the incredible outreach and service he gave to our profession. We developed a spot-testing workshop to compliment the book and taught it together 17 times at venues worldwide. With this workshop, and the many, many more he developed on other topics, his teaching impact in this format alone reached over a thousand people.

In addition to our book, I have estimated that Scott authored on 11 journal articles, 3 chapters, 5 conference proceedings, 1 Field Note pamphlet, and numerous newsletter articles. Scott gave many professional and public lectures in his career, mentored many interns, and served on numerous organizational boards, task forces, and committees.

His professional and personal partnership with wife Ellen Carrlee expanded his ability to convey the message of conservation and collections care even further. They truly exemplify the power of what two great minds and spirits can do together. I know that my life is both privileged and a lot richer for knowing him, working with him, and being his good friend and mentor for 27 years.
Andrea Rothe

It is with great sadness that we announce the passing of Andrea Rothe, who served as Senior Conservator of Paintings at the Getty Museum for over twenty years.

Born in Italy of German parents, he studied conservation in Florence and Vienna, and was an assistant to the artist Oskar Kokoschka before becoming a private conservator for the Italian state. He worked on a number of important paintings at museums and churches across Italy, and eventually became head of the prominent paintings conservation studio housed at the Pitti Palace.

Equally notable, his role in saving many paintings damaged in the Arno flooding as well his presence at many professional conferences made him an international figure in the conservation field. He was hired by the Getty in 1981 and worked on many of the Getty’s greatest acquisitions of that time, including paintings by Titian, Dosso Dossi, Fra Bartolomeo, Mantegna, Rembrandt, and Renoir.

His prior professional experience and global reputation meant that his impact at the Getty was profound. He was instrumental in bringing many international conservation leaders to the Getty to weigh in on important polices being developed at that time, and he was involved in a great number of diverse Getty activities, including the 1995 Museum/GCI The Structural Conservation of Panel Paintings Symposium (a forerunner of the Panel Paintings Initiative), the acclaimed Dosso Dossi exhibition, and research on climate controlled show-cases.

His close working relationships with curators, conservators, scholars, scientists, and students, and his incredible sensitivity to the artists whose work he was conserving, made him an outstanding colleague. Everyone who worked with him, including all of the many guest conservators and graduate interns, would agree that Andrea’s remarkable professionalism was equaled by his great sense of humor and comedic talent, and his zany view on the world will be remembered and missed by all who knew him.

Yvonne Szafran

A remembrance by Marco Grassi

Andrea’s personal background is fascinating and helps to explain the remarkable wisdom and perception with which he was to practice his profession. He spent most of his childhood and adolescence in New York, returning to Europe with his family only after the war. The Rothes settled in Florence renting a small villa above the city in a locality called ‘La Gressa.’ Andrea, an artist at heart, began painting and eventually joined the circle of Oskar Kokoschka in Salzburg. By the time our paths crossed early in 1959, Andrea had returned to Florence and was already on his way as a restorer/apprentice at the Uffizi. At that time the conservation facilities of the Florence Soprintendenza were scattered in several locations: at the “Vecchie Poste” (the former Central Post Office at the rear of the Loggia dei Lanzi), at Palazzo Pitti, and in a large space at the ground level of the Uffizi Gallery’s northern wing. Andrea worked at the latter location under the supervision of Leonetto Tintori who had achieved fame as a conservator of affresco wall paintings.

It would take the disastrous 1966 flood for the Soprintendenza to completely upend and re-invent its conservation undertaking. Where before we occasionally had to go to the nearby pharmacy to buy out-of-pocket some cotton-wool rather than wait for the bureaucracy to procure it for us, there were now virtually unlimited funds to create and equip an entirely new and consolidated facility in the spacious former military garages of the ‘Fortezza da Basso,’ the Michelangelo-designed bastions near the Central Station.

As Florence was recovering from the 1966 catastrophe - and with Andrea part of those heroic efforts – J. Paul Getty was still alive and well in London. Meanwhile, Andrea stayed on at the Uffizi with Tintori, working primarily on easel paintings. He would have greeted with total disbelief any thought that he might one day emigrate to California and that his and Getty’s paths would intersect. And yet that’s what destiny had in store when, one day in 1976 or ’77, I received a call from Burton Fredericksen, a scholar and administrator who had been associated with Mr. Getty’s art interests since Fredericksen’s days as a graduate student in the 1950’s. He inquired whether I knew Andrea and what my thoughts might be about his personal and professional profile. Getty’s mock-Pompeian Santa Monica villa had been recently completed, but it was long before anyone could imagine how that enterprise would be transformed into one of the world’s richest and most acquisitive museums.

Although I don’t recall my exact words, I know that Fredericksen got from me a most positive and enthusiastic account of Andrea. I have never for a minute imagined that my opinion closed the deal, but I hope it might have helped. At all events, the story has a happy ending – one that we all know: Andrea went on to become one of the new museum’s greatest assets, starting in 1981, deftly resolving some of the thorniest problems of its growing collection. One memorable example is the large, ex-Northampton Dosso Dossi. The mystery of its arcane mythological subject is nothing compared to the complications that the painting’s surface presented: extensive re-workings by the artist himself, ‘corrections’ nearly contemporary to the original and, of course, abundant restorations dating from various periods. ‘Reading’ such a surface is nearly as daunting a task as actually devising and implementing an adequate conservation strategy.

The Dosso project, in fact, exemplifies a central aspect of the process: the fact that conservation is not an exact science but a compendium of constant compromises. In order to successfully navigate such muddy waters the conservator must bring to bear not only consummate technical and manual skills, but a sure aesthetic and art-historical ‘eye.’ Andrea’s natural, artistic disposition was the indispensable ingredient; the rest he acquired thanks to his intelligence and perception.

Andrea’s tenure at the Getty Museum, retiring in 2002, was undoubtedly the culmination of a brilliant career, one that confirmed him as one of the most respected and influential professionals in the art world. Despite this, Andrea never lost his easy and congenial manner and, above all, his wonderful slightly self-deprecating sense of humor. His English was pure New York, whereas his fluent Italian sported a clearly affected Florentine accent about which I teased him to no end.

Our profession will not soon see another practitioner of Andrea’s character, talents, and skills.
Regional News

Alaska

Helen Alten is backing a small 1914 Chilkat Robe, in preparation for its being exhibited in the recently opened Everything From Afar Drifts Ashore exhibit. High definition security cameras with zoom capabilities will start being installed at the museum entrances, exhibits, and storage areas this week. The system will greatly improve security capabilities, including face recognition software and long-term retention of recordings. The security upgrades are funded through a grant from the Museums Alaska Collections Management Fund.

The Haines Borough has committed to replacing the museum’s server in July with a new solid-state server on which the digital collection can be stored and arranged for easier access. A grant is pending with the Rasmuson Foundation that would further enhance the digital collection.

Scott Carrlee, 1992 graduate of the Buffalo program, retired on February 28, 2018 and passed away from pancreatic cancer on April 3, 2018. He worked the past 18 years in both conservation and field services at the Alaska State Museum. Previous work included the Arizona State Museum with mentor Nancy Odegaard, the Carnegie Museum, the National Museum of the American Indian, and the Kaman-Kalehöyük archaeological site in Turkey. He was passionate about both lifting up emerging museum professionals and helping small museums and cultural centers.

A scholarship fund will be established to create summer internship opportunities in Alaskan museums. Donations noting Scott Carrlee may be made to the Juneau Community Foundation, 350 N. Franklin St, Juneau, AK 99801.

Ellen Carrlee is collaborating with weavers and other museums on a multi-year project to analyze and identify dyes in Chilkat weavings. During the biennial celebration festival, she will be on a panel at Sealaska Heritage Institute with Sarah Owens to discuss regalia care issues regarding how artifacts in continuing ceremonial use need unique solutions.

The Alaska State Museum’s herbarium is in need of digitization and cataloging, a process that will involve considerable conservation input. The museum’s summer exhibition, Titanic of the North, interprets the 100th anniversary of the sinking of the S.S. Princess Sophia and includes loans from Canadian institutions as well as Alaskan collections. Nearly 350 souls perished, marking the worst maritime loss of life in the history of Alaska or British Columbia. Artifacts have steadily been donated since the 1918 sinking, and the conservation department continues to refine its struggles with issues surrounding shipwreck artifacts.

Monica Shah and Sarah Owens both gave presentations at the 45th annual meeting of the Alaska Anthropological Association. The conservation work that was undertaken for the museum’s new Alaska exhibition. Monica and Sarah have also been participating in a weekly department program Museum Behind-the-Scenes where visitors can see how conservators, collection managers, and archivists care for the museum’s thousands of cultural objects, archival photographs, and more.

High school senior Hayate Mayer finished her Gifted Mentorship with Monica, presenting to a design and art class about two-dimensional art care and conservation. She has been working with the museum since October 2017.

Installation of the exhibit Unsettled has involved the Collections Department’s time for much of March and April. The exhibit is open until September 2018 and features 200 artworks by 80 artists living and/or working in a super-region we call the Greater West, a geographic area that stretches from Alaska to Patagonia, and from Australia to the American West. As part of this exhibition, Sarah along with other staff created and installed over 300 bowls of spices and pigments as part of Sonia Falcone’s Campo de Color.

Arizona

The Arizona State Museum Conservation Lab team has had a full few months! Gina Watkinson was awarded the Museum Association of Arizona (MAA) Individual Award of Excellence at the March 2018 annual meeting. Nancy Odegaard was awarded a 35 years achievement award by the University of Arizona in April.

She presented a public lecture about the stolen De Kooning painting at the Tucson Festival of Books; made a presentation on hazardous collections at the Museum Assn. of Arizona meeting; and presented on pesticide residues at the Society of American Archaeology meetings in DC.

Nancy and Jeanne Brako taught conservation concepts with three Navajo master weavers in two 3-day sessions at the Heard Museum in Phoenix under a Mellon Foundation grant. Gina and Nancy organized and set up a mini-exhibit that included 2 posters of text and 13 objects in the public window alcove of the ASM conservation lab to illustrates the role of conservation in the examination of Egyptian objects and their materials.

Marilyn Pool presented a poster on insect lac adhesive research at the “Celebrating the Sonoran Desert” conference in Ajo, Arizona. Teresa Moreno was the lead conservator for the exhibit Hopi Katsina Dolls: Enduring Meaning and Stylistic Change that opened in March and includes 70 items.

The Western Archeological and Conservation Center conservators are excited to welcome Betsy Burr to the team. She jumped right into helping parks with treatments and technical assistance requests, including stabilizing a camp shelf with historical significance from Florissant Fossil Beds National Monument.

Maggie Hill Kipling and Amy Molnar have been preparing objects for exhibit for Little Bighorn Battlefield National Monument. Audrey Harrison and Maria Lee recently traveled to Fort Larned National Historic Site in Kansas to pack collections for transit to WACC for treatment in preparation for exhibits and had the pleasure of driving the collections from Kansas to Tucson.

Dana Senge has been working with several teams to assess collections and develop collection management plans for several park units.

Regional Reporter
Dana Senge
Hawaii

University of Hawaii Manoa Library welcomed their new paper conservator, Liane Naaauo. Liane is a recent graduate from the Buffalo/State University of New York Program in art conservation with a focus in library and archives materials conservation. She received her B.A. from University of Hawaii at Manoa. Her training includes internships at the Boston Athenaeum, University of Iowa Libraries, and Peabody Essex Museum.

Shangri La is pleased to welcome new galleries and exhibitions coordinator Chelsea Kaufman. Formerly with the Racine Art Museum in Wisconsin, Chelsea will be responsible for the physical aspects of collections management as well as installing and de-installing exhibitions. At the same time, they are sad to say farewell to Bethany Bannister-Andrews, digital assets & collections manager, who relocated to Dallas with her fiancée. Watch this space for new developments as curator Leslee Michelsen begins to redesign the galleries.

On April 8, 2018, Mauna Kea Beach Hotel on Hawai‘i Island’s Kohala Coast welcomed home three treasured kapa (barkcloth) that have recently been conserved through Honolulu’s Bernice Pauahi Bishop Museum by Liane Naaauo, former Bishop Museum conservator, Linda Hee, contract conservator, and Nikki Dela Fuente, Bishop Museum conservation assistant. These are the first of a collection of 11 kapa made by the artist Malia Solomon in the 1960s to be treated and reframed at the museum. This work is being done as part of a collaborative effort by the hotel and museum to celebrate the arts of Hawai‘i and the greater Pacific, and to improve the care of the hotel’s extensive art collection.

The event included kapa-making demonstrations led by renowned Hawai‘i Island kapa makers Roen Hufford, Kaulani DaSilva, and Verna Takashima. The unveiling of kapa at noon was begun with an oli (chant) by Nani Lim Yap and Manaola Yap, followed by remarks from Mauna Kea Beach Hotel manager Kansas Henderson, Bishop Museum’s Ethnology collections manager Alice Christophe, and Adrienne Kaeppler, curator of Oceanic Ethnology at the National Museum of Natural History at the Smithsonian Institution.

At the beginning of the year Dawne Steele Pullman worked on smoke damaged paintings in Ojai, CA. Then she was in Hawaii treating mold on two beloved pet paintings for a client. Now she is back in Hong Kong having just finished work as the paintings conservator for Art Basel Hong Kong as well as Art Central. Since the last newsletter conservation treatments have also included mending a tear on a painting by Hartung, reintegrating a loss on a Kusama, removing pen marks on a Fontana, and extracting scary paper wasp hives from between the back of the canvas and stretcher on a Soulages! This spring she will also be working for museums abroad - an exhibit traveling to Hong Kong from France and condition reports for Australian artworks.

Rie and Larry Pace treated a large painting by Harry Tsuchidana belonging to the Pacific Club in Honolulu. Subsequently they were commissioned to carry out a survey of the 30 other paintings hanging on their walls.

An oil painting of a Martin Mars Flying Boat, painted in 1944 on a large (62" x 152") cotton fabric tarp with brass grommets along all four edges, had been rolled many decades ago and forgotten on the Pearl Harbor Naval Base. It was recently rediscovered and brought to the attention of the Pacific Aviation Museum on Ford Island. The fabricators who restore the many aircraft in the Museum’s collection constructed an aluminum frame to which the painting was mounted using small bungee cords. With the assistance of the museum’s staff and volunteers they were able to consolidate, clean, and varnish the painting after the painting was mounted to the frame.

Gregory Thomas, dba Art Care, having limited his private practice to painting conservation consultation, has a 5 x 8 foot vacuum hot table available for purchase, as well as several other pieces of studio equipment and related materials. Call (808) 397-0900 or e-mail arthcar@mac.com, if interested.

Regional Reporter
D. Thor Minnick

Los Angeles

The Getty Villa finally fully reopened to the public on April 18, 2108. They hope that all will be able to come and enjoy the Villa Reimagined with refurbished gardens, large reflecting pool, and new permanent galleries.

Two galleries highlight the art of collecting, and some of J. Paul Getty’s first acquisitions are featured. Coinciding with the Villa reinstallation are two special exhibitions. The first, Plato in L.A.: Contemporary Artists’ Visions explores several unconventional interpretations on the Plato theme. It will run from April 18–September 3, 2018 in the Villa’s temporary exhibition 2nd floor galleries.

Palmyra: Loss and Remembrance is an exhibition which brings together many limestone funerary reliefs generously loaned from the Carlsberg NY Glyptotek in Copenhagen. Two sections of an ancient relief (one from the Glyptotek and the other from Stanford) are displayed together for the first time. Photographs, books, works on paper, and digital offerings from the Getty Research Institute provide historical perspective on the ancient past and on recent events at the site of Palmyra in Syria.

Jeff Maish traveled to Tubingen, Germany to present the conservation and technical analysis of bronze lamps discovered in Vani, Republic of Georgia in 2007 at the 20th International Congress on Ancient Bronzes. The lamps had been featured in an exhibition at the Getty Villa and several other venues several years ago.

Additionally, the Getty Center, Beyond the Nile: Egypt and the Classical World opened March 27–September 9, 2018. This exhibition highlights the multi-faceted connections between Egypt and the Mediterranean over two millennia. The antiquities conservation and mount making staff worked tirelessly with curatorial, preparations, registrar’s office, exhibition design, decorative arts, and paper conservation teams to accomplish all of these exhibitions simultaneously.

Antiquities Conservation has also been busy organizing a conference on the study of ancient panel paintings: APPEAR: Ancient Panel painting, Examination, Analysis and Research which was held on May 17-18th 2018 at the Getty Villa. The presentations and posters given by project
participants highlighted the collaborative work, investigations, observations, and data collected to date.

The Getty Conservation Institute (GCI) and Los Angeles’ Museum of Contemporary Art (MOCA) are collaborating on the treatment of Jackson Pollock’s “Number 1”, 1949. The cleaning and minor structural work are being undertaken by Chris Stavroudis with consultation from Tanya Thompson, Jim Coddington, Nick Dorman, and Tom Learner. Scientific support is through Studio Sogendo (the newest AV colleague, a recent graduate of Pennsylvania Libraries in Philadelphia. They will teach the gels course at the University of Pennsylvania Libraries in Philadelphia.

“Number 1”, 1949 is being treated in public view in its own dedicated gallery in its own dedicated exhibition running from March 4 – September 3. Chris works on the painting on Thursdays and hosts a question and answer session at 11:30 and 5:30 each treatment day.

Chris was also a co-instructor with Antoinette Dwan in the second incarnation of the workshop “Use of Chelating Agents in Paper Conservation” sponsored by FAIC and held at Stanford University, 27-29 March 2018. He attended the workshop “Nanotechnologies for Conservation of Cultural Heritage”, February 12 – 16 at Institute in Brooklyn. The workshop was lead by Professors Piero Baglioni and Rodorico Giorgi from the CSGI -- Center for Colloidal and Surface Science.

In June Chris led Modular Cleaning Program workshops in Cynthia Kunie’s studio in Chicago, at the Royal Ontario Museum (co-sponsored with the Art Gallery of Ontario) in Toronto and a two-day refresher workshop at the Conservation Center in Chicago.

The paper conservation department at the Getty Museum is hosting guest scholar Anne Maheux, formerly of the Library and Archives of Canada, this Spring quarter. Anne is working closely with conservator Michelle Sullivan to study white media used for heightening in Old Master Drawings.

During Anne’s residency at the Getty, she and Michelle are also designing a 3-day workshop for the FAIC on the use of rigid gels in paper conservation. This fall, they will teach the gels course at the University of Pennsylvania Libraries in Philadelphia.

Sarah Freeman recently participated in an experts meeting organized by the Getty Conservation Institute on the use of microfadingometry in conservation. An international group of scientists and conservators participated in a public day of presentations and a round table meeting to discuss the status of the technique, new developments in instrumentation and future dissemination of MFT for the conservation community.

Ernie Mack has been working on this summer’s exhibition entitled Icons of Style: A Century of Fashion Photography 1911-2011 in the Center for Photographs here in Los Angeles. Sarah is busy preparing materials for next year’s exhibitions on the 19th century master Oscar Gustave Rejlander and contemporary photographers on the use of photomontage and staged scenes in photography.

Nancy Turner recently co-presented with GCI’s Catherine Schmidt Patterson “Documenting interventions in manuscript illumination with macro-XRF scanning,” presented at the 17th International Seminar on the Care and Conservation of Manuscripts, University of Copenhagen, Copenhagen, Denmark.

Zebala & Partners will again clean the Ramos Martinez Murals in the Margaret Fowler Garden, at Scripps College for Women in Claremont, CA. The treatment, which takes place every 8-10 years is scheduled for August 2018.

Aneta Zebala, paintings conservator and Debra Burchett-Lere, director of the Sam Francis Foundation completed their technical study about Sam Francis. Sam Francis, Artist’s Materials book is part of the Getty Conservation Institute series on artists materials. It is scheduled to be published in February 2019, as #5 in the series.

Hannah Moshier, UCLA Library’s new digitization and loan conservation coordinator, visited Bay Area conservator Tomokatsu Kawazu of Studio Sogendo to choose a good color lining for a sumi on silk painting now on exhibit at the UC Santa Barbara Museum. She was also able to visit library conservation colleagues at the UC Berkeley Preservation Department.

Collections conservator Wil Lin used his language and formidable collaboration skills to liaise with Library Special Collections and make it possible to process, digitize, and exhibit an archival collection in record time to honor the work of Japanese critic Yoshida Yoshie, who was a seminal part of Japanese social/political art movements of the 1960s and 70s.

AV specialists Yasmin Dessem and Allie Whalen (the newest AV colleague, a recent graduate of the NYU Moving Image Archiving and Preservation program) will be presenting their collaborative work in Cuba at this year’s Southeast Asia-Pacific Audiovisual Archive Assn. conference in Bangkok, Thailand. Yasmin and Allie will also be heading to Cuba again this summer for more AV preservation work.

Chela Metzger attended the Care and Conservation of Manuscripts conference for the first time this April, and the conference was followed by a week vacation in Amsterdam. Both events are a dream come true. She will also be teaching a class on early modern account book binding techniques at the 2018 Paper and Book Intensive held in Michigan.

Former Kress/FAIC conservation fellow Christina Romanowski Bean will be presenting on her UCLA French Resistance newspaper research at the conference “Renovated, rebuilt, saved – how they survived WWII. Conservation, Preservation of items from the years 1939-1945,” held at the Warsaw Rising Museum in Poland. Christina has also been lending a much needed hand in the salvage of materials affected by the recent Santa Barbara area fires and mudslides.

Last year’s summer intern from the WUDPAC program, Madison Brockman, will be back in town completing a third year internship at LACMA. The library is thrilled to have her nearby again. Collection’s conservator Wil Lin and head of conservation center Chela Metzger will both sit in on an upcoming three-day workshop at UCLA entitled “The History of the Book in China” taught by Professor James Soren Edgren. This workshop is held as part of the yearlong celebration of the 70th anniversary of the Richard C. Rudolph East Asian Library.

Tania Collas and Marina Gibbons welcome summer conservation intern Madeline Helland to the Natural History Museum of Los Angeles County. A recent graduate from the undergraduate art conservation program at Scripps College, Madeline will be working on conservation
projects within the Anthropology, History, and Mineral Sciences collections. In addition, Marina is completing the treatment of an exceptionally large morganite (pink beryl) specimen from the historic Himalaya Mine in Mesa Grande, California. Because of the provenance and unusual size of the specimen, it will be displayed at the Tucson Gem and Mineral Show in 2019.

Earlier in May, Tania presented a lecture and hands-on activity introducing students to museum pest management as part of an Urban Entomology course at UC Riverside.

The conservators at the Academy of Motion Picture Arts and Sciences are thrilled to announce that Rio Lopez will be joining the Class of 2021 at the SUNY Buffalo State College graduate program for Art Conservation. Rio joined the Margaret Herrick Library’s conservation department about a year ago as a summer intern, a position that has advanced to a part-time conservation technician role at the library. They are very sad to see her go, but wish her the best of luck and congratulate her on her next adventure.

Dawn Jaros attended the “Use of Chelating Agents in Paper Conservation” workshop taught by Antoinette Dwan and Chris Stavroudis held at Stanford University this past March.

The Academy Museum is also pleased to announce that Sophie du Bois Hunter has joined the museum’s team as their objects conservator. Sophie came from the Museum of New Mexico Museum – conservation unit in Santa Fe, New Mexico, where she has been working for the past year and half.

Conservators at LACMA have been busy with the installation of To Rome and Back: Individualism and Authority in Art, 1500-1800. The exhibition, which highlights the depth of Rome’s impact from the Renaissance to the Enlightenment, features major works from LACMA’s permanent collection.

Paintings by Fra Bartolomeo, Hendrik Goltzius, and Michael Sweerts will be included and sculptures by Giambologna and Clodion as well as works from the department of costume and textiles, decorative arts and design, Latin American art, and prints and drawings. The exhibition opens June 24th in the Resnick Pavilion and runs through March, 2019.

Among the displayed works from the department of costume and textiles are two copes from the 18th century. These Roman Catholic liturgical vestments have the appearance of a cloak. Half circle in shape, they wrap around the shoulders, hanging straight down and open in the front with a clasp joining the two sides at the breast. They are very ornately embroidered, having a rainbow of colors mixed with gold and silver wrapped threads. Amazingly, much of the silver is not tarnished, encouraging the viewer to see the designs as originally intended, white, instead of the all too common black tarnished appearance.

LACMA Curator, Leah Lehmbek, was eager to introduce a different look for displaying the copes. Instead of pin mounting them flat onto a wall mount, or wrapping them around a relatively flat pinning surface resembling a slice of pizza, Leah requested that the copes be mounted onto semi human forms. Because of the extremely delicate condition of the copes, heavy reproductions were made from velvet and linen, mimicking the weight of the originals, to reduce handling of the originals. Ethafoam mounts were carved, incorporating the natural undulations that the copes have when worn. The mounts became, in essence, overall 3-D pin mounts.

What might have taken other institutions many months to complete, the work was concluded in less than 2 months. The lead was taken by contract mount maker, Jean Neeman, assisted by LACMA’s textile conservation staff.

Joe Fronke was a contributing author to a recently published article "Modigliani in the South of France", which presented research on the painting materials and techniques of Amedeo Modigliani. The article was part of the The Modigliani Technical Research Study and appeared in Burlington Magazine this past spring. The article brought together technical analyses of three paintings of the same period from the Tate, London, LACMA and the Metropolitan Museum of Art. Joe discussed his study of LACMA’s Young Woman of the People, painted in 1918. Annette King, Isabelle Duvernois, Joyce H. Townsend, and Silvia A. Centeno were contributing co-authors. The project was organized by the Tate Modern in connection with their exhibition Modigliani.

Elma O’Donoghue recently traveled to the Metropolitan Museum of Art to help install LACMA’s Painted in Mexico 1700-1790: Pinxit Mexici exhibition. She worked with the Metropolitan Museum conservators unrolling and stretching the “Apotheosis of the Eucharist” by Rodriguez Juarez. This very large and fragile oval canvas painting dates from 1723 and Elma has overseen its deinstallation from the exhibition’s opening venue at The Palacio de Iturbide in Mexico City, its installation at LACMA and during this recent trip, installation at the Met.

Miranda Dunn is currently working on Snowy Landscape at South Norwood, 1871 by Camille Pissarro. Consolidation of lifting paint and removal of a later varnish has brought out soft colors in the architecture and the darker atmosphere in the lower part of the sky.

Kamila M. Korbelo-Dunigan is continuing to perform research into Frank Stella’s material choices and techniques to inform degradation phenomena in BAMPur (1966) and establish guidelines on treatment and care. Two focal points are the preservation of daylight fluorescent paints and fungal infestations of a group of Stella’s paintings from the 60s. The research ties up loose ends of existing research and extends the existing body of research with new aspects.

Susanne Friend and Alyson Souza of Conserving Art Associates, Inc. spent several months working on a large painting depicting Rudolph Valentino as a 14th c. Moorish nobleman in his last movie, The Hooded Falcon, based on El Cid. The painting was created for the movie by Federico Beltran Masses in 1925, but the movie was never released and Valentino died in 1931. He had the painting hanging in his home, Falcon’s Lair, in Beverly Hills. The painting had numerous problems, most of them associated with poor prior treatment. The well-known “Beltran Blue” background is very solvent sensitive, making cleaning extremely difficult.

One of the most striking features of the painting are the bright red pointy-toed shoes Valentino is sporting. The painting will be on exhibit for a year at the Ferragamo Museum in Florence Italy, for the exhibition Italy in Hollywood through May 2019.
Regional News, continued

Regional Reporter
Virginia Rasmussen

New Mexico

Local conservators have formed a local arrangements committee and have begun making plans for the WAAC meeting in Ghost Ranch in September. The first meeting included Rae Beaubien, Landis Smith, Steven Prins, Deborah Uhl, Bettina Raphael, Dale Kronkright, and Susan Barger. They are looking forward to members visiting Fair New Mexico in September.

New Mexico State Museum conservation program student, Elena Mars, got accepted at the Buffalo State University conservation graduate program. A second NMSU conservation program student, Sydney Schafer, was accepted at Queen’s University for the master’s in art conservation. And a third student, Brittany Wallace, was also accepted for the master’s in conservation at the University of Lincoln in UK.

Object conservators Maureen Russell and Larry Humetewa and textile conservator Angela Duckwall have recently completed hundreds of treatments for three exhibitions, including 1000 Years of Walking the West at the Museum of Indian Arts and Culture (MIAC). Some of the materials conserved are 1000-year old yucca sandals, quilled and beaded moccasins, and contemporary high fashion beaded footwear.

Another MIAC exhibition, Lifeways of the Southern Athabaskans features materials from the 1880s to present representing different Apache groups. Materials treated include basketry, beaded clothing, and hunting and horse gear.

And finally, the Museum of International Folk Art (MOIFA) provided lots more beaded artifacts to treat for the exhibit, Beadwork Adorns the World; 250 intricately beaded objects from around the globe. The exhibition explores the migration of beads and how different cultures used them to represent personal milestones and social status or in home décor or personal clothing.

Regional Reporter
Silvia Marinas-Feliner, M.A.

Pacific Northwest

At the Olympic Sculpture Park, Liz Brown has been working with Mark di Suvero’s studio to replace the cedar log elements for the sculpture Bunyon’s Chess. In March, the studio sent two of di Suvero’s assistants to Seattle to carve new cedar elements with local artist Brian Beck.

The winter course on preservation of collections in the University of Washington Museology MA program, taught by Nicholas Dorman and Geneva Griswold, was completed in March. The course included presentations by Lisa Duncan and J. Claire Dean, as well as a tour of the University of Washington Conservation Center in Suzzallo Library.

SAM’s conservators each had their own opportunities to attend workshops organized by other institutions. Liz participated in “Surface Treatment Strategies for Outdoor Painted Sculptures” at the Getty Center in late February. Geneva took part in the X-radiography workshop with Dan Kushel at the Fine Arts Museums of San Francisco, March 21st to 23rd. Nicholas attended the “Tempera painting between 1800 and 1950” international conference hosted by the Doerner Institut in Munich in March.

While abroad, Nicholas traveled to Italy to oversee preparations for the return of Massimiliano Soldani Benzi’s Lamentation over the Dead Christ from the National Museum of Bargello in Florence to SAM. The conservation project has been supported by the Samuel H. Kress Foundation, the Bargello, and other foundation and individual supporters.

Jane Hutchins of Tideview Conservation in Sooke, BC, visited to survey textiles in preparation for the reinstallation of the galleries at the Seattle Asian Art Museum following its renovation.

Lisa Duncan has been very busy this year, and working with two interns. She’s been getting more photographic projects and that makes her a happy conservator. Corine Landrieu has had the opportunity to work on two Pomodoro sculptures this Spring, one by Gio and the other by Arnaldo. Her work also included a large Native American pictograph rescued from an old New Mexican hotel, and various ceramic and porcelain objects, and a bronze sculpture which had suffered fire damage. She is currently in France treating a Tony Cragg and a Jenny Holzer sculpture from a private collection.

Regional Reporter: Corine Landrieu

Rocky Mountain

(A double installment, with apologies to Rocky Mountain-ites, as they were inadvertently left out of the last Newsletter.)

The conservators of Mountain States Art Conservation completed a long-term contract with the Wyoming State Museum in Cheyenne, WY. Funding was provided by the state of Wyoming as a grant designated for conservation treatments. Judy Greenfield, Paulette Reading, Cindy Lawrence, and Mark Minor treated a variety of objects. Several required cross-disciplinary collaborations. A sample of treatments included: a Wyoming silk guidon and regimental flag, both used in the Spanish American War; the first governor of Wyoming’s chair; a fossil palm frond specimen; and a 19th-century watercolor on cotton, Indian Dance.

Cindy, Paulette, and Judy also completed treatments for the exhibit Zoom In: The Centennial State in 100 Objects at the History Colorado Center in Denver. This exhibit includes a behind-the-scenes window into the collections department of the museum. While on view, Cindy treated a Virgin of Guadalupe retablo and Paulette worked on Spotted Tail’s Friendly Band, a 19th-century flag carried to indicate a truce with the American government. Judy and Paulette will continue to work on treatments on-view in the window as part of the exhibit programming in the upcoming months.

Regional Reporter
Corine Landrieu
The exhibit required several collaborative projects as well. Judy and Cindy worked on an 1880s woman’s bicycle, and Paulette and Judy treated an embroidered coat worn by Kit Carson. Paulette and Judy are also cooperatively treating some “bandsmen” figures belonging to the Brown Palace. These are exquisitely and realistically rendered figures depicting individuals in Napoleon’s army.

The staff at the Western Center for the Conservation of Fine Arts are enjoying their new digs in Wheat Ridge (a western suburb of Denver) after their move in February from the Denver studio where WCCFA was housed for over three decades. Their new address is: 11415 W. I-70 Frontage Rd N, Wheat Ridge, CO 80033.

Hays Shoop and Camilla Van Vooren treated paintings at the Gilcrease Museum in Tulsa, OK for a week in January. Hays is currently treating the life-sized Portrait of Queen Elizabeth of Bohemia by Gerrit van Honthorst from a private collection. The painting is dated 1616. Elizabeth was the sister of Charles I of England.

Beth Heller Conservation is up and running as of February in a new studio just west of Denver, continuing to share space with WCCFA. In addition to ongoing private conservation work, including consolidation of approximately 800 square feet of brittle 1880s newsprint wallpaper in the historic Milne House, Breckenridge, Beth completed 2017 CAP work, was part of a natural history collections storage survey team at CU-Boulder, and will be part of two NEH Preservation Assistance grant surveys in 2018. She was also fortunate enough to receive an FAIC grant to attend the “Cleaning and Conductivity” workshop in Ft. Worth - congratulations to Chris Stavroudis, Amy Hughes, and Daria Keynon for creating such a well-thought-out and incredibly useful course.

Jennifer Parson recently established a private practice in paper conservation in Boulder. Some of her current projects include an 18th-century Japanese hanging scroll and a 19th-century mining map of Colorado. At the end of March, she attended the FAIC workshop The Use of Chelating Agents in Paper Conservation at Stanford University.

Denver Museum of Nature and Science Conservator Jude Southward, along with private conservators Jessica Fletcher and Julie Parker, spent much of March performing conservation assessments for over 600 artifacts included in the Dead Sea Scrolls temporary exhibit at DMNS, ranging from Roman glass, Islamic pottery, and ancient textiles, to the scroll fragments themselves. Now that the exhibit has opened, Jude and Jessica have returned to the IMLS American Ethnology Treatment Grant. Over the spring months they will focus on humidifying and repairing the museum’s collection of seal gut parkas and leggings.

Congratulations to pre-program intern, Christina Haapapuro, on her acceptance to the University of Melbourne's master of cultural materials conservation program! Congratulations also to pre-program intern Tess Hamilton, on her acceptance to NYU’s Institute of Fine Arts conservation program! The conservation department at DMNS is expecting a full team of summer interns who will assist with implementing the IMLS American Ethnology Treatment Grant and other non-grant funded projects.

Beverly Perkins, Division Director at the Center of the West in Cody, Wyoming was deployed with Laura Hortz Stanton, Karen Pavelka, and Jason Church as part of FAIC’s National Heritage Responder (NHR) efforts to help cultural collections after Hurricane Maria. The team visited 11 institutions around Puerto Rico and presented a workshop to artists, students, and leaders of cultural institutions.

Conservation Solutions’ current projects include the assessment and inventory of a large collection of metal artifacts across the District of Columbia for the US Architect of the Capitol. Other DC projects include the treatment of the Emancipation & Bethune monuments, the decorative metal elements of the US Supreme Court building, and exterior laser cleaning of the US Capitol building; the assessment and treatment of 1,500 historically significant maritime artifacts for the US Department of Transportation, assessment of the Dry Tortuga lighthouse, restoration of Coral Gables’ Venetian pool, assessment of the Saturn V rocket & vacuuming of the Atlantis Space Shuttle at the Kennedy Space Center, the assessment and treatment of a significant collection of artifacts recovered from the SS South America, and conservation of military monuments on the grounds of a North Carolina Courthouse.

On November 20, 2017, the North Building at the Denver Art Museum temporarily closed to the public. On January 10, 2018, the museum broke ground for the renovation of the North Building – designed by Gio Ponti and completed in 1971. Ponti’s original structure will remain intact. Upgrades will be made to overall operational infrastructure – including a new conservation laboratory. Efforts to move the collection and other contents from the North Building began in 2016. As many can attest, moving a collection is no small task and must include the collaboration of many departments. All of conservation staff participated with collection management staff and an assembled move team over a 24-month period. The general collection move concluded with the multi-faceted planning, moving, and safeguarding of three large Native Arts objects and three outdoor sculptures.

Gina Laurin was involved in determining logistics and procedures for moving (with air sleds), ongoing monitoring, and condition checking of an oversize straw and adobe sculpture, Mud Woman Rolls On by Roxanne Swentzel. In addition, Gina, Sarah Melching, and senior mountmaker Steve Osborne tapped conservator Andrew Todd and Demiurg, LLC to assist with the complex planning and de-installation of two 150-year old Haida totem poles, 22 and 28 feet tall respectively. Kate Moomaw was involved in planning, supervising, and documenting the de-installation of three outdoor sculptures. Since completion of those activities, she has been focusing on research into and planning of the repainting of the large scale outdoor sculpture For Jennifer by Joel Shapiro.

Pam Skiles spent the winter removing aged varnish from Waterloo Bridge Sunlight Effect by Claude Monet. At the Clyfford Still Museum, she treated a small portrait of the artist’s father as well as a large, never-before-painted for an upcoming exhibit. As part of Linking Asia: Art, Trade, and Devotion, Allison McCloskey and Franciscas Lucero treated, prepared, and installed various robes, palampours, and other textiles from the near and far east.
For the same exhibition, Gina, Steve, assistant mountmaker Nick Donaldson, and conservation assistant Samantha Hunt prepared approximately 60 archaeological and ethnographic objects.

Allison, Francisca, Sarah, and conservation assistant Tess Hamilton, contributed to Jim Howard: Drawn to Glamour. The exhibition included roughly 80 artfully-rendered illustrations on paper and several fashion looks from the 1970s and 80s. As part of her fellowship, Francisca is researching a Peruvian (Paracas culture) Mantle, from the 6th or 7th century BCE. In addition to a literature review, she will be carrying out analysis and treatment in preparation for eventual display.

Eddy Colloton continues to make progress on an IMLS electronic media grant. The project is progressing with refining cataloging procedures as well as undertaking identification, ingestion, migration, and ongoing storage efforts. Kate and Eddy presented on this grant-funded project at the AIC conference in Houston. Kate will also be presenting at the NYU symposium, “It’s About Time! Building a New Discipline: Time Based Media Art Conservation.”

Regional Reporter
Julie Parker

San Francisco

Regional Reporter
Frances Prichett

Sam Li welcomed a baby boy, Henry Lord Li, in March and is on maternity leave from the Cantor Center at Stanford University. While Sam is away, Rowan Geiger’s studio, SF Art Conservation, has been working on outdoor sculpture and Beth Szuhay continues to consult on textiles. Catherine Coueignoux has been treating a recent gift of African art to the Cantor Center in addition to helping out with other objects treatments during Sam’s maternity leave. In her private practice, Catherine has been working on an interesting pair of life-size sheep sculptures covered in actual sheepskin. Google Lalanne sheep to read up on these fun pieces!

After three years of research and writing, Elise Effmann Clifford, Susan Roberts-Manganelli, and Elizabeth Pena submitted the Bay Area Conservation Science Initiative (BACSI) final report to the Getty Foundation regarding establishing a regional conservation science consortium. Many thanks to everyone who contributed, participated, and supported their endeavors.

T. Ashley McGrew was invited to participate in the inaugural meeting of the Materials Working Group for Storage, Transport, and Display sponsored by the directors of the Smithsonian’s National Collections Program, Museum Support Center, and the Museum of Natural History. The event was held on February 8 - 9 2018 in Washington, DC and Suitland, MD.

A preparator at the Cantor Arts Center at Stanford University, Ashley gave a presentation as the liaison for the Preparation Art Handling and Collections Care Information Network to AIC’s Collections Care Network. As a member of the Materials Specifications Subcommittee of the new group he worked to help set goals and define functions moving forward. The consensus was that these initial efforts were an success with potential for yielding significant benefits for collecting and exhibiting institutions.

The objects lab is currently engaged with many projects related to the permanent collections, including a reinstallment of the contemporary art galleries at the deYoung. Colleen began her fellowship in October 2016 after completing a year-long fellowship at Historic New England. Colleen created a Conservation Education gallery for the Gods in Color exhibition, updating the lab’s imaging and X-radiography equipment in the process.

After returning home from Los Angeles and LACMA, Jena joined the staff in June 2017 to assist with reinstallment of the Art of the Americas galleries and the Teotihuacan exhibition. In September 2017, the team welcomed Céline, previously at the UPenn Museum in Philadelphia. Céline is currently working on a late 17th-century bronze sculpture by Michel Anguier, Hercules and Atlas.

The Textile Lab at the Fine Arts Museums of San Francisco is working on a 34-foot tapestry by Mark Adams that needs lining and velcro (that’s really wide in tapestry terms). The lucky part of this project is that the tapestry is relatively new and is only 7 feet high. Beth Szuhay of Chrysalis Conservation has been hired to help wrangle it.

In February and March of this year, Karen Zukor traveled to Northern India, spending four weeks repairing manuscripts in a private library. Working in conjunction with Jamye Jamison, a Cleveland-based paper conservator in private practice, her work included instruction to bookbinders on conservation practices and archival materials. It was her eighth visit to the Punjab. Both Jamye and Karen were also able to visit the Conservation Center at Mehrangarh Fort in Jodhpur, where they met with Vikram Singh Rathore who is in charge of the Center.

On returning she participated in a panel discussion on “Works of Art from the Americas galleries and the Teotihuacan exhibition. In September 2017, the team welcomed Céline, previously at the UPenn Museum in Philadelphia. Céline is currently working on a late 17th-century bronze sculpture by Michel Anguier, Hercules and Atlas.

The Textile Lab at the Fine Arts Museums of San Francisco is working on a 34-foot tapestry by Mark Adams that needs lining and velcro (that’s really wide in tapestry terms). The lucky part of this project is that the tapestry is relatively new and is only 7 feet high. Beth Szuhay of Chrysalis Conservation has been hired to help wrangle it.

In February and March of this year, Karen Zukor traveled to Northern India, spending four weeks repairing manuscripts in a private library. Working in conjunction with Jamye Jamison, a Cleveland-based paper conservator in private practice, her work included instruction to bookbinders on conservation practices and archival materials. It was her eighth visit to the Punjab. Both Jamye and Karen were also able to visit the Conservation Center at Mehrangarh Fort in Jodhpur, where they met with Vikram Singh Rathore who is in charge of the Center.

On returning she participated in a panel discussion on “Works of Art from
India; Approaches to Conservation and Preservation.” The presentation took place on Skype with four practicing conservators, two in India and two in the U.S. The broadcast discussion was attended by an audience at the San Diego Museum of Art, CA and funded by the U.S. Dept. of State. Participating conservators were Paromita Dasgupta, paper conservator in Delhi and Sreekumar Menon, who is currently working on Buddhist wall paintings in Ladakh. While Karen was away, her studio was staffed by Emilie Van der Hoorn, associate paper conservator, and assistants Addison McDowell and Max Thill.

Regional Reporter
Alisa Eagleston-Cieslewicz

Texas

In news from the Amon Carter Museum of American Art, photograph conservation fellow Sarah Casto traveled to Rochester, NY this April for the 5-day workshop “Compensation for Loss in the Conservation of Photographic Materials” hosted by the George Eastman Museum.

In late April, photograph conservator Fernanda Valverde participated in an art & historic artifacts conservation roundtable during the Texas Association of Museums annual meeting in Houston. In May, Fernanda will travel to Lima, Peru to give a presentation on plastic negatives at the San Diego Museum of Art. In late May, Fernanda and Sarah co-presented a tip at the PMG tips session at the Menil Collection in conjunction with the May AIC meeting.

Whitten & Proctor Fine Art Conservation are happy to announce the appointments of two new conservators. Laetitia Joubert-Figarella joined the studio just over a year ago. She trained in France at the Ecole Superieure d’Art d’Avignon, section Conservation - Restoration. Emily Wroczynski, a graduate of UD/Winterthur, will also join the staff this fall.

Jill Whitten and Robert Proctor taught a workshop in varnishes, solvents, and retouching at the Stichting Restauratie Atelier Limburg, Maastricht in March for post graduates in the SRAL/University of Amsterdam program. Conservators from Poland, Australia, Belgium, the UK, US, and the Netherlands participated. Jill and Rob also taught a workshop on varnishes at the Menil Collection in conjunction with the May AIC meeting.

W & P recently completed the treatment of a large painting by Henriette Wyeth that is included in the exhibition Magical & Real, Henriette Wyeth and Peter Hurd that opened at the James A. Michener Art Museum in Doylestown, PA in January and travels to the Roswell Museum and Art Center in June. Rob has submitted a paper on this treatment that he hopes to present at the Fall WAAC meeting at Ghost Ranch.

Regional Reporter:
Ken Grant

WAAC Publications

Handling Guide for Anthropology Collections

Straightforward text is paired with humorous illustrations in 41 pages of “do’s and don’ts” of collection handling. A Guide to Handling Anthropological Museum Collections was written by Arizona State Museum conservator Nancy Odegaard and illustrated by conservation technician Grace Katterman. This manual was designed to be used by researchers, docents, volunteers, visitors, students, staff or others who have not received formal training in the handling of museum artifacts. Paperbound and printed on acid-free stock.

Price: $10.00
($8.00 copy for orders >10 copies)

Back Issues of WAAC Newsletter

Back numbers of the Newsletter are available. Issues Vol.1 - Vol.14, #3 (Sept. 1992) are $5/copy. Issues Vol.15 - Vol.29, #3 (Sept. 1997) are $10/copy. Issues Vol.30 (Jan. 2008) and after are $15/copy. A 20% discount will be given to libraries seeking to obtain back issues to complete a “run” and for purchases of ten copies or more of an issue.

Prices include shipping and handling.
Make checks payable to WAAC drawn in US dollars on a US bank.

For information please contact the WAAC Secretary:
Denise Migdail

Send prepaid orders to:
Donna Williams

WAAC Newsletter Volume 40 Number 2 May 2018
February 2018 marked the 10th anniversary of the installation of Chris Burden’s iconic outdoor sculpture, *Urban Light*, at the Los Angeles County Museum of Art (LACMA). To celebrate the occasion and to contribute to the museum’s commitment to energy efficiency and sustainability, LACMA replaced the existing incandescent bulbs with light emitting diodes (LEDs).

This retrofit project was the culmination of many years of research and development by LACMA’s conservation science staff to identify suitable replacements for all 309 incandescent bulbs that were part of the sculpture. In this paper the authors review the selection criteria and design of the new LED bulbs with an emphasis on the quality of the light output and on energy savings.

**Introduction**

Chris Burden’s *Urban Light* (M. 2007.147.1-.202, Figure 1) is a large-scale assemblage sculpture installed in 2008 at the Wilshire Boulevard entrance to LACMA (*Urban Light | LACMA Collections, n.d.*). The installation consists of 202 antique street lights dating to the 1920s collected from Los Angeles and surrounding cities.

Burden first began collecting street lights in December 2000 without a specific work in mind and continued gathering them for the next seven years. The street lamps were restored in his studio where they were repainted a neutral gray, rewired and missing parts were recast as needed (Freudenheim, 2008). In describing his sculpture Burden said “My artwork, *Urban Light*, is ultimately a statement about what constitutes a civilized and sophisticated city, safe after dark and beautiful to behold” (Hoffman, 2007).

Burden was actually not the first to use Los Angeles’ historic street lamps as part of an outdoor sculpture. Fifteen years earlier Sheila Klein created *Vermonica* (Figure 2), an installation composed of twenty-five street lamps (Darling, 2017). *Urban Light* is comprised of a mix of lampposts (Table 1) with one, two, or three luminaires of varying dimensions and styles (Mandelkern, 2018). The posts are positioned close together in long colonnades arranged in a grid on a
raised concrete platform measuring 60 ft x 61.8 ft. The grid is composed of 12 rows of street lights with 16 to 18 posts in each row. The 202 lampposts support 309 incandescent street lamps with three different luminous outputs.

The overall effect of the street lights with their assorted frosted globes is an omnidirectional, diffuse, warm glow. The artist acknowledged the need for maintenance, permitting the changing of light bulbs when they burned out. He also insisted the sculpture must be displayed with all luminaires working, and requested that it be turned on daily, 365 days a year, from dusk to dawn.

Three types of GE incandescent street lamp bulbs lighted the sculpture initially (Table 2). However, soon after the 2008 installation of *Urban Light*, production of the highest-wattage (327W) bulbs was discontinued as California began its phaseout of high energy-consuming incandescent light bulbs.

### Table 1

**Urban Light lamppost design and layout (Burden, 2007 and Mandelkern, 2018)**

<table>
<thead>
<tr>
<th>Lamp Type</th>
<th>Style</th>
<th>Total Height</th>
<th>Weight (lbs)</th>
<th>Base Width (in)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Doubles and Triples</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Broadway Rose Double with Globes</td>
<td>6</td>
<td>26 ft 8.5 in</td>
<td>8000</td>
</tr>
<tr>
<td>2</td>
<td>Large Downtown Double with Globes</td>
<td>9</td>
<td>26 ft 5 in</td>
<td>1275</td>
</tr>
<tr>
<td>3</td>
<td>Medium Downtown Double with Globes</td>
<td>5</td>
<td>22 ft</td>
<td>1250</td>
</tr>
<tr>
<td>4</td>
<td>Magnolia Double with Globes</td>
<td>16</td>
<td>20 ft 5.5 in</td>
<td>3000</td>
</tr>
<tr>
<td>5</td>
<td>Metropolitan Double with Lanterns</td>
<td>12</td>
<td>20 ft 2 in</td>
<td>700</td>
</tr>
<tr>
<td>6</td>
<td>Pacific Twin with Lanterns</td>
<td>6</td>
<td>20 ft 2 in</td>
<td>700</td>
</tr>
<tr>
<td>7</td>
<td>Portland Double with Lanterns</td>
<td>9</td>
<td>19 ft 8 in</td>
<td>700</td>
</tr>
<tr>
<td>8</td>
<td>Pacific Twin with Globes</td>
<td>26</td>
<td>19 ft 7 in</td>
<td>700</td>
</tr>
<tr>
<td>9</td>
<td>Glendale Double with Globes</td>
<td>6</td>
<td>19 ft 3 in</td>
<td>1225</td>
</tr>
<tr>
<td>10</td>
<td>Hobart/Llewellen Triple with Ball Globes</td>
<td>6</td>
<td>14 ft 2 in</td>
<td>1500</td>
</tr>
<tr>
<td><strong>Singles</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Pacific Single with 2-Piece Globe</td>
<td>7</td>
<td>17 ft 6 in</td>
<td>550</td>
</tr>
<tr>
<td>12</td>
<td>Portland Single with Lantern</td>
<td>6</td>
<td>16 ft 1 in</td>
<td>550</td>
</tr>
<tr>
<td>13</td>
<td>Anaheim Single with 2-Piece Globe</td>
<td>6</td>
<td>15 ft 4 in</td>
<td>650</td>
</tr>
<tr>
<td>14</td>
<td>Large Flemish King Single with Globe</td>
<td>9</td>
<td>15 ft 3 in</td>
<td>550</td>
</tr>
<tr>
<td>15</td>
<td>Metropolitan Single with Lantern</td>
<td>8</td>
<td>14 ft 4 in</td>
<td>700</td>
</tr>
<tr>
<td>16</td>
<td>Medium Flemish King Single with Globe</td>
<td>22</td>
<td>13 ft 11 in</td>
<td>500</td>
</tr>
<tr>
<td>17</td>
<td>Lynwood Single with Globe</td>
<td>17</td>
<td>12 ft 10 in</td>
<td>400</td>
</tr>
<tr>
<td>18</td>
<td>Capitol 10 Single with Globe</td>
<td>6</td>
<td>12 ft 8 in</td>
<td>425</td>
</tr>
<tr>
<td>19</td>
<td>Small Flemish King Single with Globe</td>
<td>10</td>
<td>12 ft 1 in</td>
<td>400</td>
</tr>
<tr>
<td>20</td>
<td>Bellefontaine Single with Ball Globe</td>
<td>10</td>
<td>10 ft 10.5 in</td>
<td>625</td>
</tr>
</tbody>
</table>

### Table 2

**Comparison of energy use by incandescent and LED bulbs**

<table>
<thead>
<tr>
<th>Model</th>
<th>Wattage</th>
<th>Quantity</th>
<th>Annual usage (kWh)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Incandescent</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GE42392 (1000 lumens)</td>
<td>105</td>
<td>78</td>
<td>35,872</td>
</tr>
<tr>
<td>GE42663 (2500 lumens)</td>
<td>205</td>
<td>34</td>
<td>30,529</td>
</tr>
<tr>
<td>GE21307 (4000 lumens)</td>
<td>327</td>
<td>197</td>
<td>282,155</td>
</tr>
<tr>
<td><strong>Total kWh:</strong></td>
<td></td>
<td></td>
<td><strong>348,556</strong></td>
</tr>
<tr>
<td><strong>LED ( Truly Green Solutions)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Universal Light 360</td>
<td>15</td>
<td>78</td>
<td>5,125</td>
</tr>
<tr>
<td>Custom CCT – 80% frosted</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Universal Light 360</td>
<td>19</td>
<td>34</td>
<td>2,829</td>
</tr>
<tr>
<td>Custom CCT – 80% frosted</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Universal Light 360</td>
<td>27</td>
<td>197</td>
<td>23,297</td>
</tr>
<tr>
<td>Custom CCT – 80% frosted</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Total kWh:</strong></td>
<td></td>
<td></td>
<td><strong>31,251</strong></td>
</tr>
</tbody>
</table>
bulbs. Although additional bulbs were stockpiled at the time of installation to keep the sculpture operational, it was obvious that an alternative means of lighting the sculpture was needed.

Over time the incandescent bulbs changed color and dimmed, which significantly impacted the visual appearance of the sculpture as a whole. To make matters worse, many of the luminaires leaked and during periods of heavy rainfall some bulbs would fail when moisture got into the globes. In some cases, the bulb blew out and subsequently filled with rainwater (Figure 3).

Also, heat trapped inside the globes began to degrade the insulation on the electrical wiring, leading to voltage fluctuations and short circuits, which also blew out bulbs. The lamps were burning out at an alarming rate.

Replacing the burnt out incandescent bulbs was not only time-consuming and costly but also hazardous. Maneuvering a scissor lift between the closely spaced posts - with less than an inch to spare in some locations - placed both the sculpture and the electrician in jeopardy.

Finding alternative lamps

By 2010 research began in earnest to identify replacements for the incandescent bulbs. The search for alternative means of lighting the sculpture was guided by the following selection criteria (Eng, et al., 2016):

- The light sources must be energy efficient and meet the new California energy requirements;
- They must be designated for use in enclosed outdoor luminaires;
- They must be available in bulk and compatible with the existing bulb sockets to avoid expensive retrofitting;
- The effective luminous output of the light sources should be as close to the incandescent lamps as feasible;
- The emitting elements must have approximately the same height as the filaments in the incandescent bulbs;
- The light sources should emit omnidirectionally with a “warm glow”;
- The light sources must have the same low color temperature as the original incandescent bulbs selected by the artist;
- They must meet with the artist studio’s approval.

Three contemporary lighting technologies that would satisfy California’s evolving energy requirements were investigated: Induction Lamps, Compact Fluorescent Lights (CFLs), and Light Emitting Diodes (LEDs).

Electrodeless induction lamps were initially considered because of their long service life and low lumen depreciation over time. A custom-fit Philips QL induction lamp (PowerLux® Corporation, n.d.) was given to the museum for testing in situ, and it operated without failure for several years. However, the light it cast was noticeably greener than the incandescent bulbs in the installation. Also, to retrofit Urban Light, each socket would require its own induction circuit inside the globes on the lampposts. These modifications would have been prohibitively expensive. Also, the induction lamps contain mercury which would eventually present a significant disposal cost. For these reasons, they were not given further consideration.

Some CFLs were tested as replacements for incandescent bulbs in Urban Light. Unfortunately, the spiral tube structures within the bulbs were visible at street level. The color temperatures of the bulbs were significantly colder and did not provide the warm glow of the original incandescent lights, and CFLs also contain mercury. Given these shortcomings CFLs were also not considered a viable option.

Beginning in 2014, many different commercially available LEDs were evaluated; none of which proved satisfactory. At that time few manufacturers made LEDs with the shape, high luminous outputs, and low color temperature required for Urban Light. Because the installation required three different luminous outputs, possible replacements would have to come from different commercial sources.

Using LEDs from different manufacturers is problematic because even slight variations in the fabrication processes for the light-emitting components of LEDs meant the criterion for uniform appearance of the lighted sculpture would not be met. In addition, the large, finned heat sinks in these earlier LED bulbs interfered with the omnidirectionality of the light output.

LED lamps with high luminous outputs that are also suitable for use in enclosed outdoor luminaires have only recently become available. Beginning in 2016 we collaborated closely with a local company: Truly Green Solutions, which specializes in commercial and industrial lighting, was able to provide custom designed LEDs that possessed the desired specifications for Urban Light. The specifications for the new, custom designed LED lamps are given in Table 2.

The LEDs provided by the company successfully imitated the omnidirectionality of incandescent lights by incorporating a corncob design in which individual light emitting diodes are arranged in columns placed around a vertical cylinder (Figure 4).
To obscure the individual vertical bright dots or striation patterns produced by the diodes, custom-designed milky covers were placed over the LED columns to diffuse the light. Samples were tested in the laboratory inside globes from the lamp posts. They were assessed visually, both in the laboratory and in selected locations in the sculpture. In almost all cases the individual LED diodes were not visible through the globes despite the variability in the transparency of the latter. The appearance of a 27W LED inside its globe is compared with a 327W incandescent bulb in Figure 5.

The tasks were performed in stages over a period of a week so that the sculpture could remain fully illuminated at night.

Maneuvering a scissor lift in between the closely spaced rows of lamp posts proved to be very tedious and time-consuming, requiring much patience and great skill to avoid damaging the sculpture. A boom lift had to be used to access some of posts in the center; this equipment provided barely enough room to position the operator’s basket in the midst of the lamp posts.

Most of the globes were in good condition and required only a thorough cleaning, although some had to be replaced due to cracks that formed at the base (Figure 7). The acorn and round globes had been secured with set screws, some of which may have been overtightened. Crack propagation and breakage of the globes are exacerbated by windy conditions which can occur, for example, during Santa Ana winds. To mitigate damage, all globes are now fitted with neoprene gaskets around their base, which will also keep dust and dirt from collecting inside the luminaires.

Inside some of the globes, it was found that the plastic insulation on the electrical wires was badly degraded (Figure 8, left) and needed replacement. Also, some of the wiring had been wrapped around the metal socket support, a situation which could result in a short circuit (Figure 8, right). The damaged wires were replaced, and all wiring was appropriately rerouted inside the globes.
Upon completion of the changeover to the custom LEDs, a significant improvement in the visual effect of Urban Light was noticeable. The iconic sculpture now has a more uniform light appearance and seems brighter and more welcoming than previously, while still providing a very warm glow. To date, no lamps have burned out despite several weeks of heavy rain.

Energy savings

Calculations using data on energy expenditure provided by the company suggest that the total annual energy use will be approximately 91% less than it was prior to the retrofit (Table 2). These cost savings are significant for the Museum; at LACMA’s current rate for electricity, it will only cost about $13 to keep the sculpture lit for an entire night. The additional cost of staff time that was needed to replace broken bulbs has also been essentially eliminated.

As part of LACMA’s 2008 Transformation project (BP Grand Entrance Press Release, 2008), solar panels were installed on the roof of the BP Grand Entrance adjacent to Urban Light. Although these panels were never intended to supply power directly to Urban Light, they do feed directly into the Museum’s electrical grid.

At the time of installation, it was thought that the electricity produced by the panels could offset a significant portion of the energy required by Urban Light. Initial estimates had suggested that the energy saving offset would be about a quarter of the annual energy used by the sculpture.

This proved not to be the case, because the amount of electricity that the panels can generate fluctuates widely, depending upon the time of year, the sky conditions (cloudy vs. sunny), and how clean the panels are.

With the retrofitted bulbs, it will now take only about an hour of sun each day of the year to meet the annual electrical energy needs of the new LEDs.

Summary

The research conducted by the LACMA Conservation Science staff highlighted the challenges in retrofitting traditional, incandescent light-based artworks such as Burden’s Urban Light with new, energy efficient light sources.

As lighting technologies evolve, museums will need to keep pace and replace obsolete lamps in their lighted artworks with new light sources that have similar appearances to the original ones. Planning ahead, allowing adequate time to test sample bulbs with the appropriate equipment (e.g. spectral light meters), and establishing connections with a lighting manufacturer amenable to working with us were essential to the success of the LACMA retrofit project.

The research associated with replacement of lamp bulbs will need to be undertaken periodically in the future as technology inevitably advances and today’s newest lamps become obsolete. The knowledge gained from this initial retrofit project has provided a very useful framework for undertaking future relampings of Burden’s Urban Light.

Acknowledgments

The authors wish to thank Ruby Jadwet from Truly Green Solutions for her interest and cooperation in providing custom-designed LEDs; LACMA staff including the late Dr. Frank Preusser and Roosevelt Simpson who contributed their time and expertise to the project; and Ken Lau of PowerLux Corporation for the induction lamp. LACMA is very grateful to the Leonardo DiCaprio Foundation for their support of the purchase and installation of the LEDs.

Notes

1. In 1993 local artist Sheila Klein installed Vermonica in a parking lot at the corner of Vermont Avenue and Santa Monica Boulevards; it has recently been removed and relocated across the street at the offices of Los Angeles Department of Public Works resulting in Klein stating the piece “is no longer Vermonica.” Retrieved from sheilaklein.com/etc/vermonica.html last accessed April 7, 2018.


References


Hoffman, F. Chris Burden, Thames and Hudson (2007), page 120.


One Device to Document Them All: Exploring an All-in-One Solution for Digital Condition Reporting & Beyond

by Raina Chao and Hugh Shockey

Introduction

HS: The genesis for finding a more efficient method of condition reporting was born out of my own personal practice and frustration with the traditional model of documentation. Despite computers being a regular fixture of the workplace during the course of my career, there has been limited progress in harnessing their use to improve efficiency and reduce the time required for conservators to create useful documentation for the permanent record. This is not to say that attempts have not been made (e.g. PDF annotations on iPads or purpose built software a la ConservationSpace and Conservation Studio) but in almost all instances, the solutions do not reduce the number of steps required for producing a report and are often plagued with workarounds or specialty software that may or may not integrate with collections databases. I kept asking myself, why isn’t there a better more efficient way than being stuck in the 1970s?

For several years, I had been watching the slow but steady growth of tablet computers, with on board cameras and touch sensitive screens, capable of running full-fledged operating systems. These devices offer a mobile platform with the capability of photographic capture, image annotation, enterprise networkability, and most importantly the ability to run full versions of software most often used in institutional conservation labs, including collections databases. With the idea of an all-in-one device that would allow the user to capture and annotate data then append the information directly to a collections database, I opened a conversation with the IT department at SLAM shortly after my arrival as the head of conservation. Meeting with SLAM’s IT department, I shared my thoughts of a do-it-all hardware platform, showed them what our traditional reporting looked like, and discussed the multiple steps required to generate reports using current software and tools. During our discussion, a possible solution began to emerge in the minds of our IT colleagues, using productivity software already supported by the institution that could offer flexibility and efficiency. The proposed solution was the use of Microsoft OneNote (OneNote from hereon) on Microsoft Surface tablets. The use of OneNote as a possible solution was intriguing since it is a program that is bundled with all Microsoft Office productivity suites. The evolution of our use of this combination of hardware and software is described in the following text.

Implementation

RC: I must admit that I was somewhat skeptical of the idea when I was tasked with piloting OneNote condition reporting. My hesitation was two-fold. First, I had experience using a variety of programs to create digital annotated images, but these had always been much more time consuming than I thought practical for routine condition reporting. Second, I have a fondness for multicolored pens and being able to use them for a “valid” work reason made me happy. Nevertheless, always game to play with new tools, and armed with a quick introduction from our IT department’s resident OneNote guru, Mike Peters, I dove in.

Despite my qualms, it took very little time for condition reporting via OneNote to win me over (see Fig. 1). OneNote is designed as a notetaking tool, so its basic architecture is simple and intuitive. Within each page, it allows for a large amount of flexibility in formatting – ideal for the flexibility and multiple views often required to fully document three-dimensional objects (see Fig. 2). Microsoft Surface tablets
have a familiar operating system and interface, and the built-in camera is both familiar to those of us with Smartphones and produces far higher quality images than I had expected.

Finally, and almost most importantly, the stylus functions well and responds to pressure variations, much like a real writing implement. I quickly developed a basic workflow for condition reporting using OneNote, which I have adapted over time, but not changed drastically. The detailed procedure is included in Appendix 1.

Advantages
The many advantages of this method of condition reporting were almost immediately apparent. The all-in-one nature of doing photography, annotations, and reporting on a tablet makes it easy to produce a large number of condition reports in a short span of time. With WIFI connectivity and cloud computing in the form of Microsoft 365, OneNote can be set to sync automatically, meaning that the data is constantly saving and updating. Even better, the OneNote reports can be accessed from anywhere using Microsoft 365 in almost real time, enabling colleagues to view the information quickly and collaborate as necessary. WIFI connectivity also allows condition report PDFs to be uploaded to our collections database (we use TMS) directly from the networked tablet.

Finally, the nature of OneNote and Microsoft 365, as inherent features of our institution’s enterprise Microsoft software license, means that the program itself and the Surface are fully supported by our IT department. If problems arise with software and/or hardware, numerous individuals can help assist us in solving it, which is not always the case with more boutique or proprietary software or apps.

Practical Considerations
Despite the many advantages detailed above, there are some considerations and limitations that we have yet to find solutions to that one should keep in mind.

There is no way to easily import a form or letterhead to produce “more official looking” reports. A quick search of OneNote forums reveals that this is a common complaint and therefore one that might be addressed in future software updates.

Currently, there is no easy reliable way to white balance an image using the built-in photo editing abilities of a Surface tablet. Of course, an image could be captured with an X-Rite card or other target designed to aid white balance, and the image could be corrected with Photoshop or another photo-editing program, which can be installed on the Surface. Larger notebooks sometimes run into syncing difficulties, especially over WIFI, due to the amount of data that they’re trying to update. This issue can be somewhat mitigated through organization.

OneNote’s formatting (or lack thereof) is not particularly conducive to attractive export and can often result in awkwardly cut off or duplicated images. Some tips and tricks to manage these, and other issues, follow.

Tips & Tricks
In order to make PDF export easier and prettier, it is best to insert all images that you’d like to annotate, arrange them, and then check their size and positioning via “Print Preview” before beginning your annotations. If you attempt to rescale images after the fact, the images will rescale but the annotations will not scale with them, which can be very frustrating.

OneNote does a certain amount of auto-scaling based on your content, often cutting off the display area directly adjacent to your images. In order to produce nicer margins, particularly on the right-hand side of the document, add a small dot in an inconspicuous color to your annotations at the point where you would like your margin. The dot will be barely noticeable, and the margins will be much more attractive.

If you’re in a rush, the fastest way to crop and insert images into an OneNote page is by using “Insert Screen-Clipping.” This allows you to select part or the entire previous screen you were viewing and insert it into the OneNote page as an image. This is very quick but it can be somewhat difficult to control and the images produced will be limited to the resolution of the screen (like a screen shot) rather than the full resolution that the built-in camera produces.

If you’re working on a small or detailed object, it’s best to maintain full resolution and insert images using the “Insert > Pictures” option. Images can be cropped, straightened, and adjusted as needed in the Photos application prior to insertion.

In order to alleviate syncing issues, especially as Notebooks get large and ungainly, create an archive notebook and move sections and pages to the archive once they are no longer actively being worked on. The archive Notebook can then be “closed” on each individual device to prevent the device from trying to sync all that information every time. Of course, the archive Notebook can be easily reopened and searched as needed.

Sections of the same type can be merged into “Section Groups” to reduce clutter in either the active or the archive Notebook.

Beyond Condition Reporting
The Survey
The success of the test implementation of digital condition reporting at SLAM led us to think of other potential applications for this technology. The timing coincided with the planning for a collections survey that SLAM was about to embark on. Given the size of our collection and the time allotted for the survey, we wanted to ensure that we could collect as much pertinent condition information on each object as possible, without slowing the progress of the survey. Therefore, we turned to the tool that had most recently increased our efficiency and productivity, OneNote and Microsoft Surfaces.
Conclusions

Microsoft OneNote and tablets have greatly improved our efficiency and workflow for condition reports and beyond and, with the addition of cloud computing, have the potential to improve it even further. While the use of this technology has its challenges, the benefits currently far outweigh the drawbacks. Technology, in general, is quickly improving, so it is reasonable to predict that advancements will increase functionality and ease of use.

As with any new(er) technology, there are hiccups and crashes that can be frustrating to troubleshoot. Yet the fact that both OneNote and Microsoft 365 are features of Microsoft Office, an almost ubiquitous software in most institutions, means that OneNote is often fully supported by institutional IT departments, providing a whole department of experts to turn to for help. This feature also made this system much easier to pitch to our institution’s administration; relying on tools and resources we already had made institutional buy in much easier.

While we use Microsoft Surfaces, the procedure could be easily adapted to any tablet, or, in a pinch, a Smartphone and a stylus. As we look toward applying this technology towards documentation for international loans and courier trips, these alternative hardware options are realms we intend to explore.

Acknowledgements

We would like to thank the SLAM IT department, most especially Mike Peters and Steve Carr, for their ongoing support of our OneNote and Surface usage, and for inspiring us to look in this direction in the first place. We also owe a great debt to our many interns and colleagues who have acted as Beta testers and played a key roll in the evolution of our process.

Figure 4: OneNote and Surface in use for the survey project. Photo credit: Kelsey McGinnis.
### Objects Survey Sample Template

**Monday, January 1, 2018 \n12:00 AM**

#### Condition Summary

<table>
<thead>
<tr>
<th>(Un)Stable</th>
<th>Structure</th>
<th>Surface</th>
<th>Needs Immediate Attention</th>
<th>Active Corrosion</th>
<th>Active infestation</th>
<th>Active Salts</th>
<th>Caution: Toxins</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Treatment Summary

<table>
<thead>
<tr>
<th>Major Treatment</th>
<th>Intermediate Treatment</th>
<th>Minor Treatment</th>
<th>Anoxia/freezing needed Superficial cleaning</th>
<th>No Treatment Needed Needs Monitoring Depends on Artist/Culture</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Housing/Display

<table>
<thead>
<tr>
<th>Needs Rehousing</th>
<th>Needs Mount (storage)</th>
<th>Needs Microclimate</th>
<th>Needs Scavenger</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Danger to Other Materials (Relocate and/or Isolate)</th>
<th>Danger to Itself (Ventilate and/or Separate Components)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Materials

<table>
<thead>
<tr>
<th>Needs Further Identification</th>
<th>Plant</th>
<th>Animal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Wood</td>
<td>Leather</td>
</tr>
<tr>
<td></td>
<td>Basketry</td>
<td>Semi-tanned/Rawhide</td>
</tr>
<tr>
<td></td>
<td>Other</td>
<td>Hair</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Feathers/Quills</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Horn</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tortoiseshell</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bone</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ivory/Other Teeth</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sea Shell</td>
</tr>
</tbody>
</table>

#### Textile

<table>
<thead>
<tr>
<th>Other Organics</th>
<th>Gums/Resins</th>
<th>Rubber</th>
<th>Plastic</th>
<th>Hard (Thermoset)</th>
<th>Flexible (Thermoplastic)</th>
<th>Ceramic</th>
<th>Unglazed</th>
<th>Slipped</th>
<th>Glazed</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Stone

<table>
<thead>
<tr>
<th>Marble</th>
<th>Granite</th>
<th>Semi-precious</th>
<th>Other -</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Glass

<table>
<thead>
<tr>
<th>Metal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Silver</td>
</tr>
<tr>
<td>Copper Alloy</td>
</tr>
<tr>
<td>Iron/Steel</td>
</tr>
<tr>
<td>Lead</td>
</tr>
<tr>
<td>Tin Alloy</td>
</tr>
<tr>
<td>Gold</td>
</tr>
<tr>
<td>Other -</td>
</tr>
</tbody>
</table>

#### Surface Decoration

<table>
<thead>
<tr>
<th>Coating</th>
<th>Dye</th>
<th>Embroidery</th>
<th>Enamel</th>
<th>Engrave/Etch/Incise</th>
<th>Gilding</th>
<th>Inlay</th>
<th>Paint</th>
<th>Bimetallic</th>
<th>Veneer</th>
<th>Other -</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Structure

<table>
<thead>
<tr>
<th>Complete</th>
<th>Missing Parts/Attachments</th>
<th>Fragmentary</th>
<th>Loose Parts/Attachments</th>
<th>Mobile Parts/Attachments</th>
<th>Extra Components</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Surface

<table>
<thead>
<tr>
<th>Abrasions (overall/local)</th>
<th>Scratches, Dents, Gouges (overall/local)</th>
<th>Wear</th>
<th>Soiling</th>
<th>Dusty</th>
<th>Grime</th>
<th>Fingerprints</th>
<th>Particulates</th>
<th>Residue (from use/other)</th>
<th>Losses</th>
<th>Flaking</th>
<th>Paint</th>
<th>Other -</th>
<th>Delamination</th>
<th>Powdered/friable</th>
<th>Paint</th>
<th>Other -</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Biological Activity

<table>
<thead>
<tr>
<th>Insect</th>
<th>Fungi</th>
<th>Red Rot</th>
<th>Rodent</th>
<th>Mold</th>
<th>Other -</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Active Inactive</td>
</tr>
</tbody>
</table>

#### Metal

<table>
<thead>
<tr>
<th>Corrosion/Rust/Tarnish</th>
<th>Light</th>
<th>Medium</th>
<th>Heavy</th>
<th>Active Inactive</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Glass/ Glaze

<table>
<thead>
<tr>
<th>Crizzling/crazing</th>
<th>Sweating or Weeping</th>
<th>Iridescence</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Plastic</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Brittle</th>
<th>Sticky</th>
<th>Discolored</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Notes: 

- Checking
- Cracks
- Delamination
- Dents
- Loss(es)
- Fraying
- Spalling
- Tearing/Breaks
- Warping/Distortion
- Previous Repairs
Appendix 1 – Procedure for Condition Reporting Using Microsoft OneNote

Due to the fast pace of technological advancement, our implementation of digital condition reporting has already spanned a generation of Microsoft Surfaces and countless software updates. For the sake of space, these instructions were created with the most recent versions (as of writing) in mind.

Create an overall Notebook. These can be individual, or shared so that multiple people can contribute and view the information. At SLAM we have a Conservation Notebook accessible to all members of the conservation department.

Add a new Section to the Notebook. This can be renamed for a project, exhibition, etc.

Within a section, add a new page for each object you want to condition and rename it with the object’s accession and/or loan number and title (e.g. 1:2017 – Vase) or other standardized nomenclature to identify the object. The page will automatically be time stamped when it is created, this will appear under the title unless it is manually edited or removed.

Open the Camera app and take all images of the object that you’d like to include in the condition report. These can include multiple overall views, details, etc. These images can be viewed in the Photos App after capture; this app can also be used to crop and edit images.

Insert images into the OneNote page via one of two methods:

The “Screen Clipping” function under the Insert tab will allow you to select part or the entire screen, insert it into the OneNote page as an image. The selection is restricted to the screen that was most recently viewed before OneNote, so it is important to switch only between the image and OneNote for the import to be successful. The resolution of images imported in this fashion is restricted to the Surface’s screen resolution.

The “Insert Picture” function under the Insert tab allows you to import a full resolution image into the OneNote page. This can be an image captured with the built-in camera and stored in the “Camera Roll” or from another source such as a DSLR camera – whether captured and uploaded or captured tethered directly to the Surface itself. The lender, collections database, and the internet are also possibilities.

Arrange and scale the images as desired to produce a logical order. Depending on the desired output, this step will be of greater or lesser importance as it influences the attractiveness of the final exported report. The positioning and sizing for PDF output can be checked by going to File > Print Preview. This step may need to be repeated several times until the desired appearance is achieved. Annotate condition issues using the variety of colors and styles available under the Draw tab.

Create a key for the annotated issues. If there are multiple pages, ensure a key is visible on each page.

Add text to the report to accompany the images, if desired. Generate a PDF version of the condition report by going to File > Export > Page > PDF. Whole Sections or Notebooks can also be exported, though the page formatting does not always translate well in these batch exports.

Appendix 2 – Procedure for Creating and Using Survey Forms

Due to the fast pace of technological advancement, our implementation of digital condition reporting has already spanned a generation of Microsoft Surfaces and countless software updates. For the sake of space, these instructions were created with the most recent versions (as of writing) in mind.

Create an overall Survey Notebook.

Subdivide the Survey Notebook by media type by creating individual sections for Objects, Paintings, Paper, etc.

Format the first Page of the section to be limited to an 8 ½ x 11 in area by going to the View tab, selecting “Paper Size.” This allows the form to reflect a typical paper survey form. Annotations and text can go beyond these limits, but it allows for ease in creating the template.

Determine the parameters and condition issues desired for capture by the survey form. Objects are particularly difficult. Our three main sections are Condition and Recommendations Summary (top), Materials (middle), and Condition Issues (bottom).

Each section is comprised of a number of categories and check boxes and an area for additional comments or notes. Check boxes can be inserted by: right-clicking or pressing the screen and holding until the menu appears and then selecting “Tags” and picking a check box from the drop down menu. Alternatively, the command Ctrl+1 will also produce a check box. It is easiest to create columns of checkboxes with associated text.

Add areas of text by simply selecting an area of the page and beginning to type.

Arrange the check boxes and text in order to produce the form layout desired. Additional features such as lines can be added for clarity by going to the Insert tab and selecting the desired shape. Once the form is finalized, save it as a template by going to the View tab > Paper Size > “Save current page as template.” It will then prompt you to name the template. The name doesn’t matter, but make sure to check the “Set as default template for new pages in the current section” option in the dialog box. Now, each time a new page is added to the section, the blank survey form will appear.

This can be repeated in each section for different forms customized to media type.

To use the forms, rename each page to a predetermined nomenclature that uniquely identifies the object and fill out the form. Check boxes can be checked by selecting them with finger pressure or the stylus. Add notes by typing in designated areas, using the stylus to write freehand, or using the script to text function. Typed responses can be searchable, while freehand annotations are not.

In special cases, the OneNote forms can also support additional annotations or images as needed. Once complete, the forms can be exported as PDFs by going to File > Export > Page > PDF.
**Membership**

*Chris Stavroudis, membership secretary*
“Rare Roman mosaic, Featuring Toga-Wearing Figures, Discovered in Israel,” Fox News, 02/08/2018

Archaeologists in Israel have uncovered a rare multicolored Roman mosaic featuring three toga-wearing figures during excavations in the ancient city of Caesarea. The mosaic, which dates back to the 2nd or 3rd-century A.D, measures around 11.5 feet by 26 feet.

“It features three figures, multicolored geometric patterns and a long inscription in Greek,” explained Dr. Peter Gendelman and Dr. Uzi ‘Ad, excavation directors for the Israel Antiquities Authority, in a statement. “The figures, all males, wear togas and apparently belonged to the upper class.

The mosaic has been damaged by a building that was constructed on top of it during the Byzantine period about 1,500 years ago. The dig, which is receiving financial support from the Edmond de Rothschild Foundation and the Caesarea Development Corporation, is part of the largest conservation and construction project ever undertaken in Israel.

This involves reconstruction work on the Crusader-era entrance bridge to Caesarea and the construction of a promenade from the nearby town of Jisr a-Zarqa to Caesarea National Park.

As part of the project, archaeologists have also unearthed a large, opulent building that dates back to the Byzantine period. The Roman mosaic was discovered beneath the building.

“Boston’s Museum of Fine Arts Hires Puppy to Sniff Out Art-Munching Bugs,” Mental Floss, 01/12/2018

Some dogs are qualified to work at hospitals, fire departments, and airports, but one place you don’t normally see a pooch is in the halls of a fine art museum.

The Museum of Fine Arts, Boston is changing that: As The Boston Globe reports, a young Weimaraner named Riley is the institution’s newest volunteer. His job is to sniff out the wood-and-canvas-munching pests lurking in the museum’s collection. During the next few months, Riley will be trained to identify the scents of bugs that pose the biggest threat to the museum’s paintings and other artifacts. (Moths, termites, and beetles are some of the worst offenders.) Riley is just one additional resource for the MFA’s existing pest control program. As far as the museum knows, it’s rare for institutions facing similar problems to hire canine help. If the experiment is successful, bug-sniffing dogs may become a common sight in art museums around the world.

“Graffiti Artists Awarded $6.7 Million for Destroyed 5Pointz Murals,” New York Times, 02/12/2018

Ruling that graffiti — a typically transient form of art — was of sufficient stature to be protected by the law, a federal judge in Brooklyn awarded a judgment of $6.7 million on Monday to 21 graffiti artists whose works were destroyed in 2013 at the 5Pointz complex in Long Island City, Queens.

In November, a landmark trial came to a close in Federal District Court in Brooklyn when a civil jury decided that Jerry Wolkoff, a real estate developer who owned 5Pointz, broke the law when he whitewashed dozens of swirling murals at the complex, obliterating what a lawyer for the artists had called “the world’s largest open-air aerosol museum.”

Though Mr. Wolkoff’s lawyers had argued that the buildings were his
to treat as he pleased, the jury found he violated the Visual Artists Rights Act, or V.A.R.A., which has been used to protect public art of “recognized stature” created on someone’s else property.

“They’re back! Restored Tapestries Return to the Frick Museum,” Pittsburgh Tribune, 02/23/2018

The Frick Museum in the residential neighborhood of Point Breeze in Pittsburgh is again fully festooned. All four tapestries purchased by Helen Clay Frick for the museum’s rotunda are once again on display.

Three were removed in early 2017 for conservation treatment. All tapestries in the Frick’s collection date to around 1510 and reflect the advanced skills of artists creating complex pictorial weavings at a time when fine tapestries were more valuable than paintings – due to the cost of materials and the months of labor required for their production.

Over time, gaps begin to form between colors and their own weight pulls on the fibers, causing breakage. Staining and fading can also be issues, as can earlier repairs that age or discolor differently than the original weaving.

The conservation treatment was completed by textile conservator Julia Dippold, who has worked with the Frick’s tapestry collection for nearly 20 years.

“Delaware Man’s Thumb Prank Fractures U.S.-China Relations,” The News Journal, 02/27/2018

No one really knows what 24-year-old Michael Rohana, of Bear, was thinking when he decided it would be good move to sidestep the rope blocking the entrance to the Franklin Institute’s ancient terracotta warriors exhibit last December and pocket a 2,200-year-old thumb.

According to an FBI affidavit, Rohana, allegedly smug around the Philadelphia exhibit wielding a cell phone flashlight. Stepping up to the platform, he draped one arm over a $4.5 million cavalryman, snapped a selfie, and broke off the statue’s left thumb as a souvenir.

It took more than two weeks for museum security to notice the missing digit and report it to the FBI’s Art Crime Team. Investigators tracked the thumb to a desk drawer in Rohana’s home.

Local art experts say the theft highlights a real tension between in-your-face, immersive art experiences and exhibitions that are best appreciated from afar. “It’s always this battle because you want to attract people and make art accessible,” said Lara Kaplan, a Baltimore objects conservator and a graduate of the Winterthur/University of Delaware Program in Art Conservation. “You have to weigh that against the risk and the cost of damaging important artworks.”

Chinese authorities, meanwhile, are livid that no one was guarding the 10 life-size soldiers, which are on loan through Sunday. Part of a platoon of thousands, they were commissioned by Emperor Qin Shi Huang in the 3rd century B.C. to protect him in the afterlife. The cultural relics authority of China’s Shaanxi Province has called on the United States to “severely punish” the thumb thief and will soon dispatch two experts to repair the warrior.

“Bierstadt Painting Takes a Vacation in Florida,” Seven Days, 03/09/2018

Last October, Albert Bierstadt’s massive 1867 painting “The Domes of the Yosemite” left its permanent home at the St. Johnsbury Athenaeum for restoration.

It was carefully rolled around cardboard tubing and driven to Miami, Fla., where conservationists at the ArtCare Conservation Studio repaired the weakened canvas, removed a synthetic varnish applied in the 1950s, and performed some minor inpainting.

The 10-by-15-foot painting, commissioned by a Connecticut financier in 1867 and sold at auction to a member of the Fairbanks family shortly after, has resided at the Athenaeum since 1873. But before it returns home, it’s making a pit stop at the Charles Hosmer Morse Museum of American Art in Winter Park, Fla., about three hours north of the conservation studio.

This is the first time since its installation at the Athenaeum that Bierstadt’s painting has been shown outside of St. Johnbury. A recent press release from the Athenaeum explains that the Morse Museum has a connection to Horace Fairbanks, the founder of the Athenaeum, and to St. Johnbury.

“How Refugees are Conserving Iraq and Syria’s Extraordinary Monumental Heritage,” The Art Newspaper, 03/13/2018

Thirty men and women have entered the World Monument Fund’s (WMF’s) new training centre in Mafraq, Jordan. Four months in to a conservation stonemasonry training programme, they can carve arabesques for Zakhrafa jambs, prepare rectangular billet mouldings or work an ovolo return.

Not yet perfect, but astonishing progress, made more remarkable given this is happening 12 miles from the Syrian border, and that most students are refugees who have fled from the neighbouring conflict.

With the backing of the UK government’s Cultural Protection Fund, a £30m initiative to protect heritage in conflict-affected areas of the Middle East and North Africa, the centre’s aim is simplicity itself—take three problems and turn them into a solution. The problems: how to conserve extraordinary monumental heritage in Iraq and Syria, such as the ancient souk of Aleppo or al-Hadba’ minaret in Mosul, damaged by Islamic State or caught in the crossfire of opposing armies.

The issue is exacerbated by the depletion of skilled craftspeople; once the dust of conflict settles, there will be few able to carry out restoration. At the same time, thousands sit in refugee camps, lives on hold, seeking a future.

The solution: train refugees to become the craftspeople and conservators of the future. Give them a skill to help restore their nation’s heritage. Over the coming year, the centre will train more than 35 people, with the support of the British Council, which co-ordinates the protection fund, and a local partner, the Petra National Trust.
“These Ancient Mosaics were Buried on the Lawn of the Museum of Fine Arts, St. Petersburg,” Tampa Bay Times, 03/16/2018

Why were the mosaics buried on the lawn in the first place? That was a mystery. But there they were at the Museum of Fine Arts, St. Petersburg, two ancient pieces dating from the years 100 to 300, sitting beneath the grass on the east lawn for nearly 30 years.

The discovery on the lawn led to an excavation last week. Now, conservationists are working to preserve the mosaics, a process museum guests will be able to witness.

The mosaics have been in the museum’s hands for many years. The art was discovered in the 1930s when a team from Princeton University excavated a site on the ancient city of Antioch, on the border of modern-day Turkey and Syria. The museum acquired five mosaics from the excavation in the mid-1960s as one of its first acquisitions. One was embedded in a fountain in the sculpture garden. One went on display in the Membership Garden. One was stowed under the stage of the Marly Room.

Someone buried the remaining two in the lawn outside the gates of the sculpture garden sometime in 1989. Executive director Kristen Shepherd has had a longtime affection for the mosaic on display in the Membership Garden, under which she would sit and do her homework when she visited the museum as a high school student.

Shepherd hired art and architecture conservation firm Rosa Lowinger and Associates to perform the excavation and the restoration. From the small hole that revealed a piece of the mosaic, the conservator was able to determine the depth of the hole and the condition of the piece and put a plan into action. The months-long conservation process is happening at an outdoor lab on the east lawn, and museum visitors will be able to watch.

“Piero’s Icon Restoration Completed,” ANSA, 03/26/2018

After a three-year-long restoration, Renaissance master Piero della Francesca’s Resurrection can once again be admired in its original glory at the civic museum of Sansepolcro, the little Tuscan town where the artist was born sometime around 1420.

The fresco described by Giorgio Vasari, the father of modern art history, as the Renaissance pioneer’s “most beautiful” artwork and hailed by British novelist Aldous Huxley in 1925 in the essay “The most beautiful painting in the world”, is a symbol of Sansepolcro.

Indeed, gunnery officer Anthony Clarke in 1944 famously decided at the last minute not to bombard the town because he remembered about the masterpiece he would otherwise have risked destroying.

The long restoration work was carried out by Florence’s Opificio delle Pietre Dure, one of Italy’s most well-known restoration laboratories. The restoration saved the fresco from damage caused, among other things, by earthquakes, an exhaust pipe, and 40 previous minor restorations including one in the 19th century in which sodium hydroxide was used to “clean” the painting.

It also unveiled new details of the fresco’s history. Cecilia Frosinini, director of the Opificio’s department for the restoration of painted murals, said that, following the work, “we can affirm with certainty what has been said for a long time: the painting was moved here from somewhere else, perhaps even from an external wall of the building.”

“It is one of the oldest and most monumental” relocations of a fresco in the history of art, Frosinini said, adding that moving it to its current location where the town meetings were held was an “identity choice”. The restoration also shed new light on the artist’s technique and color choices.

“Historic Tbilisi Academy of Arts Building Being Brought Back to Life,” Georgia Today, 04/19/2018

The Tbilisi Academy of Arts is one of those hidden jewels of the capital of Georgia. The old building of the academy, constructed in the 1850s, was the first Art Academy in the Caucasus and the cultural hub of the region.

The building, decorated with intricate stained-glass windows and lined with enamel and mirror mosaics, represents a unique example of a historic and cultural landmark. The building has endured more than a century, experiencing many hardships, including Soviet terror, to survive to today. Yet over the last decades, the crumbling building has been on the verge of destruction, alarming both the academy’s personnel and art enthusiasts who know its value.

In 2015, the Apolon Kutateladze Academy of Arts was selected for a rehabilitation project by the Ministry of Culture and Sport of Georgia. The long-awaited restoration and maintenance works were launched the same year, with the professors and students of the academy and graduates getting readily involved.

The renovation works are ongoing and are expected to be finished by the end of 2018. The main features of the Academy are the halls adorned with mirrors, designed by specially invited Khanjar artisans from Iran when the building was originally constructed. Art experts compare these halls to the interiors of eastern-style palaces of Iran or the famous Golestan Palace, one of the oldest historic monuments in the city of Tehran, and of world heritage status.

Built over 200 years of Qajar rulership, between 1925 and 1945 a large portion of the buildings of the Golstan Palace complex were destroyed on the orders of Reza Shah. As such, Georgia’s Academy of Arts possesses precious examples of royal decoration that no longer exist.

“King Tut gets a Remodel: How Conservators are Trying to Protect the Tomb from Tourists,” Los Angeles Times, 03/27/2018

With a new King Tut exhibition packing in the crowds in Los Angeles, the Getty Conservation Institute announced Tuesday that it has nearly finished a multiyear project focused on conserving the tomb of Tutankhamun and protecting it from the tourist hordes in Egypt.

Random Horoscope #2

Because learning comes with its own payoff, it can be seductive to stay in the education bubble. Step out and apply it.
AYMHM, continued

The Getty Conservation Institute carried out the work in collaboration with Egypt’s Ministry of Antiquities. It included the conservation of wall paintings, improvements to the tomb’s infrastructure and environmental systems, and the training of stewards for the site.

Researchers conducted an intensive study to understand the tomb’s condition, assess the causes of deterioration and decide how best to address them, said Neville Agnew, the GCI senior principal project specialist who oversaw the project.

One of the most intriguing aspects of the Tut project, Agnew said, was the evaluation of mysterious brown spots that marred the wall paintings. Egyptian authorities wondered if new visitors were causing those brown spots to grow.

DNA and chemical analysis confirmed that the spots were created by microbiological organisms that were dead and therefore not capable of spreading. The spots were left alone because they are embedded in the paint and because they reflect the history of the site.

“It tells us something archaeologically about the tomb,” Agnew said. “It tells us that the tomb was certainly sealed when it was wet. Tutankhamun was 19 when he died. He wasn’t expected to die. They hastily overhauled a smaller tomb, hastily entombed him, and sealed it up. Not only was there wet plaster in the walls, there was lots of organic material — wood and flower offerings, all of which contain moisture and promote microbiological growth.”

“The Met Resurrects Italian Old Master’s Entombment,” The Art Newspaper, 04/03/2018

Michael Gallagher has just been appointed the deputy director for conservation at the Metropolitan Museum of Art.

But soon after he joined the New York institution 13 years ago, he says, a particular Italian Renaissance work caught his eye. He felt that The Entombment (1554) by Moretto da Brescia “was one of the saddest-looking pictures in the collection—in terms of its condition and appearance—yet I always felt it was just a truly great painting”.

Only recently has he had the chance to work on it: after more than a year in the studio, the restored painting will be back on view later this month, as the collection undergoes a substantial rehang while the museum renovates its skylights.

“What I found fascinating was that we have people on my department’s Visiting Committee, who love pictures like this, but on seeing it after cleaning asked, ‘is this a new acquisition or was it in store?’ And yet it has never been off view since 1912.”

Gallagher has taken away earlier retouches, removed and replaced the glue lining that no longer held down the seams of the different parts of the canvas, “so the picture almost looked bisected”, and retouched areas that had “quite a few losses”.

Moretto’s painting could have ended up in the collection of the National Gallery in London but it was not for a typically 19th-century sense of propriety on the part of its director between 1855 and 1865, Charles Lock Eastlake.

He went to look at the painting at least twice, according to the Metropolitan Museum of Art’s European paintings curator Andrea Bayer, and “realised it was the late masterpiece by the artist”. But there was a problem. “He was disturbed by the fact that the Virgin is holding up the dead Christ and has her hand directly on his stomach and it is right in the middle of the picture. And he just found it indecorous,” Bayer says.

“Conservation Exhibition to Reveal the Mysteries of ‘Blue Boy’,” ArtFix Daily, 05/03/2018

The exhibition “Project Blue Boy” will open at The Huntington Library, Art Collections, and Botanical Gardens on Sept. 22, 2018, offering visitors a glimpse into the technical processes of a senior conservator working on the famous painting as well as background on its history, mysteries, and artistic virtues.

One of the most iconic paintings in British and American history, The Blue Boy, made around 1770 by English painter Thomas Gainsborough (1727-1788), is undergoing its first major conservation treatment.

Home to the work since its acquisition by founder Henry E. Huntington in 1921, The Huntington will conduct some of the project in public view, as part of a year-long educational exhibition that runs through Sept. 30, 2019.
The Blue Boy requires conservation to address both structural and visual concerns. “Earlier conservation treatments mainly have involved adding new layers of varnish as temporary solutions to keep it on view as much as possible,” said Christina O’Connell, The Huntington’s senior paintings conservator working on the painting and co-curator of the exhibition.

“The original colors now appear hazy and dull, and many of the details are obscured.” According to O’Connell, there are also several areas where the paint is beginning to lift and flake, making the work vulnerable to paint loss and permanent damage; and the adhesion between the painting and its lining is separating, meaning it does not have adequate support for long-term display.

For the first three to four months during the year-long exhibition, The Blue Boy will be on public view in a special satellite conservation studio set up in the west end of the Thornton Portrait Gallery, where O’Connell will work on the painting to continue examination and analysis, as well as begin paint stabilization, surface cleaning, and removal of non-original varnish and overpaint.

It then will go off view for another three to four months while she performs structural work on the canvas and applies varnish with equipment that can’t be moved to the gallery space.

Once structural work is complete, The Blue Boy will return to the gallery where visitors can witness the inpainting process until the close of the exhibition.

“A New Technique for Removing Tape from Artworks May Have Led to the Discovery of a Michelangelo Drawing,” ArtNet News, 05/22/2018

This week, a group researchers at the University of Florence published a study through the Proceedings of the National Academy of Sciences detailing an innovative new technique for removing tape from prints and drawings.

The method employs a water-retentive hydrogel with nano-sized droplets of organic solvents to remove old pieces of pressure-sensitive tape (known as PSTs) without damaging the substrate underneath. The emulsion slowly penetrates the surface and softens the adhesive underneath without touching the paper.

Simply apply the gel to the top of tape, trim it down to size, then peel both off. The development is bigger than it sounds. Tape, it turns out, is a nightmare for restorers. For one, it’s used for wide variety of purposes, including matting, temporary conservation, or simply to adhere or fasten the work to another object. It’s also nearly impossible to remove without compromising the integrity of the paper underneath—a problem that only gets worse with age.

This is why a non-invasive removal method is a game-changer. So far, the scientists have restored tape-damaged drawings by Maria Helena Vieira da Silva, Stanley William Hayter, and Lucio Fontana, among others. But their biggest coup came when they were successfully able to remove a piece of tape on a 16th-century drawing from the Sistine Chapel. Underneath, they discovered the inscription, “di mano di Michelangelo” (“from Michelangelo’s hand”).

“It’s About Time! Building a New Discipline: Time-Based Media Art Conservation,” NYU News, 05/15/2018

Time-Based Media (TBM) art conservation has been identified as a priority by many leading cultural organizations worldwide due to ever increasing TBM collections and their rapid deterioration and obsolescence.

In order to address the diverse challenges of media art conservation, a new generation of media conservators will need to cross the disciplinary boundaries of computer science, material science, media technology, engineering, art history, and conservation.

The Institute of Fine Arts, NYU, will host its first ever TBM symposium on May 20-22, 2018 at the Institute of Fine Arts and at the Courant Institute of Mathematical Sciences. The symposium will promote education and training opportunities for TBM as a new specialization within art conservation and will provide a forum for educators, artists, art historians, museum curators and directors, collectors, gallerists, engineers, computer scientists, and conservators to foster TBM art conservation as a discipline on an international level.

The symposium will conclude the project Time-Based Media Art Conservation Curriculum Development at the Conservation Center of the Institute of Fine Arts, NYU. The curriculum uses a multi-disciplinary approach and is embedded in the conceptual framework of contemporary art conservation, already a strength of the Institute’s program.

“Neil Armstrong’s Dyna-Soar Abort Training Aircraft Being Restored for Moon Landing Anniversary,” SpaceFlight Insider, 05/20/2018

A piece of Neil Armstrong’s pre-astronaut space history is being restored in preparation for next July’s 50-year anniversary of the Apollo 11 Moon landing.

The Armstrong Air and Space Museum in the astronaut’s hometown of Wapakoneta, Ohio, is restoring the Douglas F5D Sky Lance aircraft that he flew as part of his training for the Dyna-Soar project, which was cancelled in December of 1963.

The Skylancer has been on outdoor display in front of the museum since its opening in 1972. Naturally, the years and the elements have caught up with the aircraft, which has been repainted only twice in the 46 years it has been on display.

Restoration is being performed by the Intermuseum Conservation Association (ICA), a regional art conservation center based in Cleveland, Ohio. The project is being carried out in two parts, with the aircraft’s exterior being restored by Thomarios in Copley, Ohio, while the aircraft’s cockpit is restored by ICA’s Mark Erdmann, a specialist in restoring fine metalwork.

Random Horoscope #4

George Burns once suggested, “Happiness is having a large, loving, caring, close-knit family in another city.” Your support system can take many forms.
Thomarios has a history of restoration work on vintage aircraft and spacecraft, including the restoration of the giant Saturn V rocket that is on display at the Apollo/Saturn V Center at Kennedy Space Center in Florida.

The restoration on the aircraft is expected to be completed sometime by Summer 2018. The more detailed and intricate restoration of the cockpit will take much longer, but is expected to be ready for incorporation into its new display in time for the 50-year anniversary in July 2019.

“Ivan the Terrible Painting ‘Seriously Damaged’ in Pole Attack,” The Guardian, 05/26/2018

One of Russia’s most famous and controversial paintings, which depicts Ivan the Terrible cradling his dying son, has been badly damaged after a man attacked it with a metal pole in a Moscow gallery.

The canvas – Ivan the Terrible and His Son Ivan on November 16, 1581 – was completed by the Russian realist Ilya Repin in 1885 and portrays a grief-stricken tsar holding his son in his arms after dealing him a mortal blow, a historical incident the veracity of which some Russian nationalists dispute.

In a video released by the interior ministry, the unnamed suspect appears to confess, saying he went to see the painting before drinking vodka and becoming “overwhelmed by something”.

Ivan the Terrible is regarded as one of the cruelest rulers in Russia’s long history: a bloodthirsty and paranoid tyrant who killed his own son. But the figure of the 16th-century tsar has recently has undergone something of a rehabilitation, with some nationalists arguing that the painting in question was actually part of a foreign smear campaign.

The State Tretyakov gallery in central Moscow said the man attacked the canvas just before closing time on Friday. It said he got past a group of gallery staff, picked up one of the metal security poles used to keep the public away from the painting and struck its protective glass covering several times.

“As a result of the blows the thick glass ... was smashed,” the gallery said. “Serious damage was done to the painting.

The canvas was pierced in three places in the central part of the work which depicts the figure of the tsarevich.” Olga Temerina, the deputy head of the Grabar Art Conservation Centre in Moscow, told RIA Novosti that the canvas may need to be replaced, but that the centre still had Repin’s notes from the previous restoration effort to help.

“Conservators Consult Forbes Pigment Collection to Solve Artwork Mysteries,” Chemical & Engineering News, 06/04/2018

Susan Costello is a conservator of objects and sculpture at the Straus Center for Conservation & Technical Studies, part of the Harvard Art Museums. Costello painstakingly restores ancient objects by painting over cracks and other defects. Typically, her paint job matches the original so closely that museum visitors can’t tell her handiwork from that of the ancient artisans.

When a paint she’d used to fill in the head and chest of a figure on a 2,400-year-old ancient Greek vessel began transforming from terracotta to an unsightly gray hue without explanation, panic set in. The ceramic that Costello had trouble with is known as the “Bell Krater: Torch Race.” Costello had spent more than 100 hours restoring this volleyball-sized vessel from around 420 BCE that was once used to mix water and wine.

The object had spent thousands of years buried in the ground. The fired ceramic surface had worn away in places. White lines revealed where bits of the object had been glued back together. The ominous gray blotch appeared about a year after Costello’s first restoration effort.

Costello turned for help to the Forbes Pigment Collection, an array of more than 2,500 pigment samples. Conservation scientists had previously analyzed the ceramic and found that it contained chloride salts. “We thought maybe these chloride salts were reacting with the paint,” Costello says.

To test that hypothesis, she treated a terracotta pot from a garden store with HCl and broke it into bits. On each bit, she painted a different color she maybe these chloride salts were reacting with the paint,“ Costello says.

When you lose your sense of humor, you have passed the point of productive work. Take a break.

Random Horoscope #5

NYA Newsletter      Vol ume  40  Number 2    May 2018